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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross Technology. 

Our mission is to:

1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love

Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.

If anything at all with your Ross experience does not live up to your expectations be sure to reach out to 
us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality customer 
experience every day. This code of ethics hangs on the wall of all Ross Video locations to guide our 
behavior:

1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong and 
it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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and will be repaired without charge for materials or labor within this period. See the “Warranty and Repair 
Policy” section in this manual for details.

Environmental Information

The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction 
of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse 
or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health 
conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional 
waste administration. You can also contact Ross Video for more information on the environmental performances of 
our products.
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Ross Video Limited 
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Ross Video Incorporated 
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USA 13669-0880

General Business Office: (+1) 613  652  4886

Fax: (+1) 613  652  4425

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail (Technical Support): techsupport@rossvideo.com

E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com
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mailto:solutions@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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Introduction
This guide covers the installation, configuration, and use of the GATOR-KEY. The following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.

• “Before You Begin” provides general information to keep in mind before installing and configuring your 
GATOR-KEY.

• “Hardware Overview” provides a basic introduction to the GATOR-KEY hardware features including the 
cabling and monitoring features of the rear module.

• “Physical Installation” provides instructions for the physical installation of the GATOR-KEY and its rear 
module into an openGear frame.

• “Cabling” provides an overview of connecting input and output devices to the rear module of the GATOR-KEY.

• “Getting Started” outlines how to display the GATOR-KEY interfaces in DashBoard.

• “Configuring the Ethernet Settings” provides instructions for configuring the GATOR-KEY network settings.

• “Reference Setup” provides instructions for specifying the reference source for the GATOR-KEY.

• “Configuring the Outputs” provides instructions for setting the card output video format.

• “Configuring the GPI/Tallies” outlines how to configure each GPI/Tally independently on the GATOR-KEY.

• “Keying” summarizes the GATOR-KEY keying features.

• “Mattes” outlines how to set up a matte color and assign a matte generator to an external key.

• “Transitions” outlines how to specify the post transition behavior, configure the TAKE button, set a transition 
rate, and perform basic transitions.

• “Media File Management” outlines how to select and configure the two Logo channels for the GATOR-KEY.

• “Using RossTalk” outlines how to establish a connection point between GATOR-KEY and an external device.

• “Upgrading the Software” outlines how to upgrade the GATOR-KEY via DashBoard.

• “DashBoard Interface Overview” summarizes the menus and parameters of the GATOR-KEY tabs in 
DashBoard.

• “Technical Specifications” provides the specifications for the GATOR-KEY.

• “Service Information” provides information on the warranty and repair policy for your GATOR-KEY.

• “Software Licenses” provides third-party software license information for your GATOR-KEY.

• “Glossary”provides a list of terms used throughout this guide.

Related Publications

It is recommended to consult the following Ross documentation before installing and configuring your 
GATOR-KEY:

• DashBoard User Manual, Ross Part Number: 8351DR-004

• MFC-OG3-N User Manual, Ross Part Number: 8322DR-004

• OG3-FR Series User Manual, Ross Part Number: 8322DR-005

• OGX-FR Series User Manual, Ross Part Number: 8322DR-204

Documentation Conventions

Special text formats are used in this guide to identify parts of the user interface, text that a user must enter, or a 
sequence of menus and sub-menus that must be followed to reach a particular command.
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Interface Elements

Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For example:

In the Network tab, click Apply.

User Entered Text

Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides

Text set in bold and italic represent the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the DashBoard User Manual.

Menu Sequences

Menu arrows are used in procedures to identify a sequence of menu items that you must follow. For example, if a 
step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions

Star icons are used to identify important instructions or features. For example:

 Contact your IT department before connecting to your facility network to ensure that there are no conflicts. They 
will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for your device.

Contacting Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest 
telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service 
and technical support is provided directly by Ross Video personnel. During business hours (Eastern Time), 
technical support personnel are available by telephone. After hours and on weekends, a direct emergency technical 
support phone line is available. If the technical support person who is on call does not answer this line immediately, 
a voice message can be left and the call will be returned shortly. This team of highly trained staff is available to 
react to any problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 613-652-4886

• After Hours Emergency: (+1) 613-349-0006

• E-mail: techsupport@rossvideo.com 

• Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Before You Begin
If you have questions pertaining to the operation of GATOR-KEY, contact us at the numbers listed in the section 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.

Overview

The GATOR-KEY is a high quality UHD/HD-SDI video keyer with five internal static/animation playout channels 
and one external key/alpha channel. An excellent device for keying external devices such as character generators, 
and graphic systems into a program feed and/or keying with four internal logo channels. 

The GATOR-KEY offers full key control with shaped and unshaped keying, self key or auto key, and gain and clip 
control. The Background A and B inputs allows for background dissolves and V-Fades behind the external key 
source. All four inputs have line synchronization, locked to an external analog reference, to ease system timing 
requirements. Four independent outputs for Program, Preview, and Clean Feed offers Fade to Black capability.

The GATOR-KEY processes embedded audio on the Background A and Background B inputs. Any audio groups 
present on the inputs are carried through to the outputs. During transitions, the audio ramps smoothly between A 
and B sources, matching the video transition.

Functional Block Diagram

Figure 2.1 provides a general overview of the GATOR-KEY workflow.

Figure 2.1  Functional Block Diagram
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Features

Some features of the GATOR-KEY include:

• Support for SMPTE 274M, 296M, 170M, and ITU-R BT.470-6 standards

• 2 External Key + Alpha can come from any SDI input (user configurable) or any of the 2 logo channels

• Keys can be transitioned independently

• Support for cross fade, cut, v fade, fade/cut, and cut/fade transitions

• Supports 2 internal logo/animation playout channels

• Program/Preset background input cay be any SDI input (user configurable)

• Supports RossTalk automation requests

• Fully compliant with openGear specifications

• 5 year transferable warranty

User Interfaces

Control is available via the DashBoard client software, as well as through third-party protocols. Optional SNMP 
monitoring is also available. 

DashBoard Interfaces

The DashBoard client software enables you to monitor and control openGear frames and cards from a computer. 
DashBoard communicates with cards in the openGear frames through a Network Controller Card installed in the 
frame. This controller card is required in order to use DashBoard to control and monitor the GATOR-KEY.

The GATOR-KEY includes DashBoard interfaces for configuration and operation. The interfaces are accessed by 
expanding the GATOR-KEY node in the DashBoard Tree View and selecting the appropriate sub-node. 

For More Information on...

• displaying the DashBoard interfaces, refer to the chapter “Getting Started” on page 27.

SNMP Monitoring

The Network Controller Card in the openGear frame provides optional support for remote monitoring of your card 
using Simple Network Management Protocol (SNMP), which is compatible with many third-party monitoring 
tools.

For More Information on...

• the available SNMP monitoring features, refer to the Management Information Base (MIB) file for your 
GATOR-KEY.

• SNMP monitoring features in the openGear frame, refer to the MFC-OG3 Series User Manual.

Third-Party Protocols

The GATOR-KEY supports a communication link between a computer based editing or automation system and the 
GATOR-KEY.

For More Information on...

• setting up an automation system with the GATOR-KEY, refer to the chapter “Using RossTalk” on page 53.
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Hardware Overview
This chapter presents information on the GATOR-KEY card-edge controls and features. 

Overview

The GATOR-KEY is an openGear modular system composed of two sub-systems.

• a main board which connects to a rear module and the openGear frame midplane

• a rear module that provides physical connectors

Up to five GATOR-KEY modules may be installed into an openGear frame.

Main PCB Overview

The main PCB is a typical openGear card. An ejector on one end secures the module to the slot inside the openGear 
frame, and the other end inserts into a connector on the back of the rear module.

Figure 3.1  GATOR-KEY — Base Card Components 

Reset Button

Pressing this button resets the microprocessor and re-initializes the card. This is a hard reset of the card. This action 
should only be before as advised by Ross Video Technical Support.

Back Components

The main PCB also includes a Micro SD card slot. This slot is located on the backside of the main PCB and just 
above the ejector. (Figure 3.2)

Figure 3.2  GATOR-KEY — SD Card Location

 It is recommended to ensure the SD card is properly seated in its slot on the PCB before installing the 
GATOR-KEY in the frame.

Reset button

Micro SD Card
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GATOR-KEY Rear Module Overview

This section provides an overview of the connections and cabling designations for the GATOR-KEY rear modules.

8322AR-317 Rear Module 

The following connections are available when the GATOR-KEY is installed with the 8322AR-317 rear module:

• 6 SDI inputs on HD-BNCs

• 6 SDI outputs on HD-BNCs

• 1 independent reference input signal

• 4 GPIO connections

Each rear module occupies four slots in the openGear frame and accommodates one GATOR-KEY card. Figure 3.3 
indicates the implemented cabling designations.

Figure 3.3  Cabling Designations — 8322AR-317 Rear Module

Notice — Installing the 8322AR-317 in a frame other than the OG3-FR or OGX-FR could damage the 
card, the rear module, or both.
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8323AR-325 Rear Module 

The following connections are available when the GATOR-KEY is installed with the 8323AR-325 rear module:

• 6 SDI inputs on HD-BNCs

• 6 SDI outputs on HD-BNCs

• 1 independent reference input signal

• 4 GPIO connections

Each rear module occupies two slots in the openGear frame and accommodates one GATOR-KEY card. Figure 3.3 
indicates the implemented cabling designations.

Figure 3.4  Cabling Designations — 8323AR-325 Rear Module

For More Information on...

• the rear module, refer to the section “Installing the Rear Module into the openGear Frame” on page 20.

• cabling the inputs and outputs, refer to the chapter “Cabling” on page 23.

Notice — Installing the 8323AR-325 in a frame other than the OGX-FR could damage the card, the 
rear module, or both.
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Physical Installation
Installing an GATOR-KEY card into the openGear frame requires you to remove the blank plates in the designation 
frame slots, install the required rear module into the frame rear panel, and then install the GATOR-KEY card into 
the required frame slot.

If you have questions pertaining to the installation of GATOR-KEY, contact us at the numbers listed in the section 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.

For More Information on...

• the technical specifications for the GATOR-KEY, refer to the chapter “Technical Specifications” on page 73.

Before You Begin

These installation guidelines assume the following:

• Ensure the openGear frame is properly installed. Refer to the User Guide for your frame.

• An MFC-OG3-N Network Controller Card installed in your openGear frame.

• A valid IP addresses is available for the GATOR-KEY.

• If the rear module is already installed in the openGear frame, proceed to the section “Installing the 
GATOR-KEY Card into a Frame” on page 20

Static Discharge

Throughout this chapter, please heed the following cautionary note: 

Removing the Blank Plates from the Rear Panel

When a frame slot is not populated with an openGear card, a blank plate must be installed to ensure proper frame 
cooling and ventilation. 

To remove a blank plate from the openGear frame

1. Locate the slots in the openGear frame you wish to install the GATOR-KEY into. 

2. If you are using an 8322AR-317 rear module, it is recommended to use the following slot combinations:

3. Use a Phillips screwdriver to unfasten each blank plate from the openGear frame backplane.

4. Remove each blank plate from the chassis and set aside.

 You must remove two Blank Plates (covering four slots) in the openGear frame.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.

Notice — Installing the 8323AR-325 in a frame other than the OGX-FR could damage the card, the 
rear module, or both.

• Slots 1, 2, 3, 4 • Slots 13, 14, 15, 16

• Slots 5, 6, 7, 8 • Slots 17, 18, 19, 20

• Slots 9, 10, 11, 12
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Installing the Rear Module into the openGear Frame

If the rear module is already installed in the openGear frame, proceed to the section “Installing the GATOR-KEY 
Card into a Frame” on page 20.

To install a rear module into the openGear frame

1. For each retaining screw on the rear module, push the o-ring to the end of the screw (but not off the screw). 
This will help to align the rear module to the frame backplane in step 3.

Figure 4.1  Location of the O-ring on the 8322AR-317 Rear Module

2. Seat the bottom of the rear module in the seating slots at the base of the frame’s backplane.

3. Align the top holes of the rear module with the screw holes on the top-edge of the frame backplane.

4. Using a Phillips screwdriver and the provided screw, fasten the rear module to the backplane.

 Do not fully tighten the screws until after installing the card and you have verified that the GATOR-KEY card 
aligns with the rear module. 

Installing the GATOR-KEY Card into a Frame

The slot the GATOR-KEY installs into depends on the slot combination you installed the rear module in. This 
allows adequate spacing to avoid damaging the card, the cards installed in the neighboring slots, or both.

Refer to Table 4.1 for valid slot combinations when using the 8322AR-317 rear module.

Table 4.1  Card Slot Combinations — 8322AR-317

Rear Module is Installed in Card Installs into Slot

Slots 1, 2, 3, 4 2

Slots 5, 6, 7, 8 6

Slots 9, 10, 11, 12 10

Slots 13, 14, 15, 16 14

Slots 17, 18, 19, 20 18

O-ring
O-ring
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Refer to Table 4.2 for valid slot combinations when using the 8323AR-325 rear module.

To install the GATOR-KEY into the openGear frame

1. Locate the slot the GATOR-KEY card will slide into.

2. Verify that the GATOR-KEY card aligns with the rear module.

3. Using a Phillips screwdriver fasten the rear module to the backplane using the provided screws.

 Do not over tighten the screws.

4. Hold the card by the edges and carefully align the card edges with the slot rails in the frame.

5. Fully insert the card into the frame until the card is properly seated in the rear module.

Table 4.2  Card Slot Combinations — 8323AR-325

Rear Module is Installed in Card Installs into Slot

Slots 1, 2 1

Slots 3, 4 3

Slots 5, 6 5

Slots 7, 8 7

Slots 9, 10 9

Slots 11, 12 11

Slots 13, 14 13

Slots 15, 16 15

Slots 17, 18 17

Slots 19, 20 19
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Cabling
If you have questions pertaining to the installation of GATOR-KEY, contact us at the numbers listed in the section 
“Contacting Technical Support”. Our technical staff is always available for consultation, training, or service.

While the examples in this chapter depict the 8322AR-317 rear module, the information is also applicable to the 
8323AR-325.

Cabling the Ethernet Port on the Frame

The GATOR-KEY is connected to your network via the Network Controller Card in the openGear frame. This 
enables the GATOR-KEY to interface with other cards in the frame, and the computer running the DashBoard 
client. After a physical connection is established, DashBoard is used to configure the network settings for the 
GATOR-KEY.

 You must provide an Ethernet connection to the openGear frame as outlined in its User Guide.

Before You Begin

Contact your IT department before connecting to your facility network to ensure that there are no conflicts. They 
will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for your GATOR-KEY.

For More Information on...

• downloading and installing DashBoard, refer to the DashBoard User Manual.

 If difficulties or problems are experienced when connecting the GATOR-KEY to a network hub, contact your 
network administrator.

Cabling for the Reference Input for the GATOR-KEY

The openGear frame provides two reference input connections that the GATOR-KEY can use as a reference source. 
Refer to the User Guide for your frame to learn more about cabling these ports.

The GATOR-KEY rear module also includes a REF IN HD-BNC that can assigned as a local reference input.

For More Information on...

• on specifying the analog reference source for your card, refer to the chapter “Reference Setup” on page 33.

To connect a reference source to the GATOR-KEY rear module

1. Connect one end of a Belden cable to the REF IN HD-BNC on the GATOR-KEY rear module.

2. Connect the other end of the same Belden cable to the applicable output port on the external reference source 
device.

Figure 5.1  GATOR-KEY — Reference Input Cabling on the 8322AR-317 Rear Module
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Video Signal Cabling

Each rear module provides connections for up to six SDI inputs and six SDI outputs.

SDI Inputs

Connect your input video signals to the SDI IN HD-BNCs on the rear module as required. There are six HD-BNC 
SDI inputs available on each rear module. (Figure 5.2)

Figure 5.2  8322AR-317 Rear Module Cabling — SDI Inputs

SDI Outputs

Connect your destination devices to the SDI OUT HD-BNCs on the rear module as required. There are six 
HD-BNC SDI outputs available on each rear module. (Figure 5.3)

Figure 5.3  8322AR-317 Rear Module Cabling — SDI Outputs

GPI/Tally Cabling

The GATOR-KEY has four bi-directional pins labeled GPI/O 1-4 on the terminal block of the rear module. Ports 
are user programmable to be either an input (GPI) or an output (Tally) using the GPI/Tally Setup tab in DashBoard. 
Electrically, the ports are setup for contact closure to ground, with 4.75kohm pull-up resistor to +5V, so they default 
to a logical high state.

The ports are available on two 3-pin connectors located on the rear module. The 3-pin mating connectors are 
provided with the rear module. The default state for the GPI/O contacts is active low signaling. This way, if the card 
is removed from the openGear frame, no external events will be inadvertently asserted by the card. This also means 
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that if a cable is absent from the rear module, no GPI or Tally will be triggered and executed inadvertently by the 
card.

Connect your destination devices to the GPIO pins on the rear module as required. (Figure 5.4)

Figure 5.4  8322AR-317 Rear Module Cabling — GPI/Tally

For More Information on...

• configuring a GPIO port, refer to the chapter “Configuring the GPI/Tallies” on page 37.
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Getting Started
This chapter provides instructions for launching DashBoard, assigning an initial IP address to the GATOR-KEY, 
and accessing the GATOR-KEY interfaces in DashBoard.

If you have questions pertaining to the operation of GATOR-KEY, contact us at the numbers listed in the section 
“Contacting Technical Support” on page 12. Our technical staff is always available for consultation, training, or 
service.

Before You Begin

Ensure that:

• The openGear frame that houses the GATOR-KEY displays in the Basic Tree View of DashBoard.

• The GATOR-KEY displays as a sub-node in the openGear frame tree.

• Your facility IT Department provided the required network settings to be assigned to the GATOR-KEY.

Launching DashBoard

DashBoard must run on a computer that has a physical wired ethernet connection. Wireless connections do not 
allow device discovery.

For More Information on...

• downloading and installing the DashBoard client software, refer to the DashBoard User Manual.

• the GATOR-KEY interfaces in DashBoard, refer to the chapter “DashBoard Interface Overview” on page 57.

To launch DashBoard

1. Ensure that you are running DashBoard software version 8.4.0 or higher.

2. Launch DashBoard by double-clicking its icon on your computer desktop.

Configuring the Initial Network Settings

Once the GATOR-KEY is physically installed and cabled to your facility network, you will need to assign it an 
initial IP Address in order to gain full access to the card menus, options, and status fields in DashBoard. 
Establishing an initial IP Address enables DashBoard to communicate with the GATOR-KEY and update the Basic 
Tree View with the GATOR-KEY sub-node.

 This procedure requires a reboot of the card.

To assign the initial network settings for the GATOR-KEY

1. Launch DashBoard.

2. Expand the openGear frame node to display a list of cards installed in that frame.

In the example below, the GATOR-KEY card is installed in Slot 2 of Frame_10.

3. Double-click the GATOR-KEY node under the frame node.

The Network interface displays in DashBoard.
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4. Select the Network tab.

5. Use the Mode menu to select Static.

6. Use the Static IP Address field to assign a unique IP Address to the GATOR-KEY card.

7. Use the Subnet Mask field to assign the subnet mask for the card.

8. Use the Gateway field to specify the gateway for communications outside of the local area network (LAN) the 
card will use.

9. Click Apply.

The card is temporarily taken off-line during the reboot of the card to apply the new settings.

10. Verify the new network settings as follows:

a. Close the Network interface.

b. Refresh the Basic Tree View.

c. Expand the openGear frame node to display a list of sub-nodes.

d. Verify that the GATOR-KEY displays as seen in the example below.

Accessing the GATOR-KEY Interfaces in DashBoard

Once you establish the initial network settings for the GATOR-KEY, you can access the Global, Configuration, and 
On Air Control interfaces. These interfaces provide options for configuring, monitoring, and operating your 
GATOR-KEY in DashBoard.

For More Information on...

• the Global interface, refer to the section “Global Interface” on page 57.

• the Configuration interface, refer to the section “Configuration Interface” on page 61.

• the On Air Control interface, refer to the section “On Air Control Interfaces” on page 67.
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To display the Global interface in DashBoard

1. Launch DashBoard.

2. In the Basic Tree View of DashBoard, locate the openGear frame the GATOR-KEY is installed in.

3. Expand the openGear frame node to display a list of sub-nodes.

4. Locate the GATOR-KEY node in the frame tree.

5. Expand the GATOR-KEY node to display a list of sub-nodes for the card.

6. Double-click the Global sub-node.

The Global interface opens in the right pane of the DashBoard window.

To display the Configuration interface in DashBoard

1. Launch DashBoard.

2. In the Basic Tree View of DashBoard, locate the openGear frame the GATOR-KEY is installed in.

3. Expand the openGear frame node to display a list of sub-nodes.

4. Locate the GATOR-KEY node in the frame tree.

 Look for the slot number that corresponds to the physical frame slot the GATOR-KEY is installed in.

5. Expand the GATOR-KEY node to display a list of sub-nodes for the card.

6. Double-click the Configuration sub-node.

The Configuration interface opens in the right pane of the DashBoard window.
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To display the On Air Control interface in DashBoard

1. Launch DashBoard.

2. In the Basic Tree View of DashBoard, locate the openGear frame the GATOR-KEY is installed in.

3. Expand the openGear frame node to display a list of sub-nodes.

4. Locate the GATOR-KEY node in the frame tree.

5. Expand the GATOR-KEY node to display a list of sub-nodes for the card.

6. Double-click the On Air Control sub-node.

The On Air Control interface opens in the right pane of the DashBoard window.
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Configuring the Ethernet Settings
The openGear frame provides ethernet connections via the ports on its rear panel, and the Network Controller Card 
installed in the frame. This chapter outlines how to configure the GATOR-KEY 

 If difficulties or problems are experienced when assigning IP addresses, contact your network administrator.

Before You Begin

Ensure that:

• The openGear frame that houses the GATOR-KEY displays in the Basic Tree View of DashBoard

• An MFC-OG3-N Network Controller Card installed in your openGear frame

• The GATOR-KEY displays as a sub-node in the openGear frame tree

• You have contacted your facility IT Department for the required settings to be assigned to the GATOR-KEY

Configuring the Internal Frame Ethernet Settings

Once you have assigned an initial IP Address to the card, you can then specify the network settings that will be used 
when the GATOR-KEY utilizes the GigE network switch available on the Network Controller Card installed in the 
same openGear frame.

The port on the Network Controller Card enables GATOR-KEY to communicate with DashBoard and with other 
cards in the same openGear frame.

 Ross Video recommends using a static IP Address.

To specify the network settings for the GATOR-KEY to use via the Network Controller Card

1. Navigate to the Global interface as outlined in the procedure “To display the Global interface in 
DashBoard” on page 29.

 If the GATOR-KEY does not display a sub-node in the openGear frame tree view, refer to the section “Accessing 
the GATOR-KEY Interfaces in DashBoard” on page 28.

2. Select the Network tab.
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3. If you are manually configuring the ethernet settings for the GATOR-KEY:

a. Use the Mode menu to select Static.

b. Use the Static IP Address field to specify the new static IP Address for the GATOR-KEY. This is the 
address the card will use within the openGear frame.

c. Use the Subnet field to specify the subnet mask for your network. 

d. Use the Gateway field to specify the gateway for communications outside of the local area network (LAN) 
the card will use.

4. If you want the network settings to be automatically obtained, select DHCP from the Mode menu.

5. Click Apply to save the new settings.

6. Reboot the GATOR-KEY card as follows:

a. Click Reboot. This button is located on the bottom of the tab.

b. Monitor the reboot progress.

Configuring the Remote Logging Feature

The GATOR-KEY enables you to implement a streaming log that captures status information of the system. This 
feature is useful for troubleshooting.

 A centralized Syslog server must be installed in your system. Refer to the documentation that accompanied your 
centralized Syslog server for installation and setup information.

To configure the remote logging feature

1. Navigate to the Global interface as outlined in the procedure “To display the Global interface in 
DashBoard” on page 29.

2. Select the Network tab.

3. Use the Remote Logging field to specify the IP Address of the device that will capture and store the status 
information of the GATOR-KEY.

 You must press Enter after typing the IP Address into the Remote Logging field.

4. Reboot the GATOR-KEY card as follows:

a. Click Reboot. This button is located on the bottom of the tab.

b. Monitor the reboot progress.
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Reference Setup
The openGear frame supports a distributed frame reference, allowing incoming reference signals to feed timing 
information to all openGear cards in that frame. Thus, a single signal can be used for multiple cards.

Specifying a Global Analog Reference Source

When using a progressive format reference signal to lock an interlaced format video signal, the lock will be 
Frame Locked but Field indeterminate.

Frame Rate Compatibility

Table 8.1 provides an outlines the GATOR-KEY frame rate compatibility.

For More Information on...

• the options in the Analog Reference Status menu, refer to Table 17.4.

To specify a global analog reference source for the GATOR-KEY

1. Navigate to the Global interface as outlined in the procedure “To display the Global interface in 
DashBoard” on page 29.

2. Select the Setup tab.

Table 8.1  Output/Reference Compatibility 
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3. Use the Analog Reference Source menu to specify the source for the reference input signal. 

 If you select Frame 1 or Frame 2, the input video frame rate must match this reference frame rate. 

Monitoring the Reference Signal via DashBoard

The status of the GATOR-KEY may be monitored via its fields in the DashBoard client software or the LEDs 
located on the front panel of the openGear frame.

To configure the reference alarm for the GATOR-KEY

1. Navigate to the Global interface as outlined in the procedure “To display the Global interface in 
DashBoard” on page 29.

2. Select the Global Alarm Enables tab.

3. Select the Reference Error box to enable the Card state status field, located in the top left corner of the Global 
interface, to report when the analog reference signal is not detected.



GATOR-KEY User Guide (v2.0) Configuring the Outputs • 35

Configuring the Outputs
This chapter provides instructions for setting the card output video format.

Before You Begin

Keep the following in mind when configuring your SDI signals:

• The SDI output timing is fixed on the GATOR-KEY and is set to approximately 0.5 lines after the reference.

• Each video input has a line sync that can support a full line of HD video including horizontal blanking.

• All video inputs must be timed with the reference. The input tolerance is approximately +/- 0.5 line. Exceeding 
this tolerance will result in the output shifting of 1 line. The status fields in the Configuration > Video Format tab 
displays a Yellow indicator when operating outside the range of the line sync. In such cases, a vertical shift of 1 
line or more may occur.

• All of the video inputs must be the same video format as specified in the Configuration > Video Format tab in 
DashBoard. If the formats do not match, the card reports an error in the DashBoard Signal Status area and on the 
card-edge LEDs.

• The Program and Preset sources can be any of the two internally generated Logo channels or external inputs, or 
an internally generated black.

• Each of the six SDI outputs can be configured as Program, Preset, Alpha 1, Alpha 2, or one of four Clean Feeds.

Output Basics

This section gives an overview of how video is controlled by the GATOR-KEY. This includes video sources, video 
layering, and preview.

Video Sources

The GATOR-KEY has access to two basic types of video sources: external and internal. All video sources can be 
assigned to video source (crosspoint) buttons. By pressing a crosspoint button on a bus, the video source assigned to 
that button is selected.

• External video sources come from SDI inputs on the rear module.

• Internal video sources come from internally generated video, such as any of the two internally generated Logo 
channels, or an internally generated black.

To select a video source on a bus, you must identify the bus you want to assign a video source to and then press the 
crosspoint button you want to select on that bus.

Video Layering

Key layering is fixed for the GATOR-KEY and starts with Background and proceeds to Keyer 4.

Figure 9.1  Video Layering



36 • Configuring the Outputs GATOR-KEY User Guide (v2.0)

Video Preview

Video preview allows you to use an additional monitor to preview what the next shot is going to be. The Preset bus 
of GATOR-KEY shows what is selected for the next transition. This includes the keys and background video 
sources that will be on-air after the next transition.

Specifying the Video Format

When setting the card output video format, ensure to specify the same format as in the input video signal.

For More Information on...

• the options in the Output Format menu, refer to Table 17.7.

To specify the output video format

1. Navigate to the Configuration interface as outlined in the procedure “To display the Configuration interface 
in DashBoard” on page 29.

2. Select the Video Format tab.

3. Use the Output Format menu, located in the Output Format area of the tab, to specify the card output video 
format.

 Ensure that the specified output format matches the input video format.

4. Select the Clip at White box to enable the GATOR-KEY to clip to SMPTE white on all outputs.

5. Select the Clip at Black to enable the GATOR-KEY to clip to SMPTE black on all outputs.



GATOR-KEY User Guide (v2.0) Configuring the GPI/Tallies • 37

Configuring the GPI/Tallies
This chapter outlines how to configure each GPI/Tally independently on the GATOR-KEY.

GPI Communication Setup

When configured as a GPI, a port behaves as an input, and can be used to trigger actions such as Cut/Dissolve the 
Key and/or Background. A push-button switch, or an ON-OFF switch, may be directly connected between the port 
and the adjacent ground pin. Alternatively, an external device may drive a low level. Minimum pulse duration is 
1ms, anything shorter will be filtered out.

Typically, users will configure the GPI for Edge trigger. This means that the action is carried out either on the 
falling edge (button is pushed), or rising edge (button is released), depending on which Polarity is selected. 
Alternatively, users may configure the GPI for Level trigger. In this mode, the action is carried out on both the 
rising and falling edges, so there are effectively two states. The Polarity control can be used to invert the behavior. 
Regardless of the trigger type, GPI commands may be overridden by other command inputs such as serial protocols. 

The Edge option enables the GPI to act as a latching trigger. Edge triggers are used when you want to toggle 
between settings. This option enables the GPI to execute a specific function.

• If configured for Falling Edge, the selected function is executed when the GPI input signal transitions from High 
to Low.

• If configured for Rising Edge, the selected function is executed when the GPI input signal transitions from Low 
to High. 

• Edge triggered GPI signals are sampled once per frame and the associated function is executed only once per 
frame. The minimum pulse width is 1 millisecond.

• Typically, the edge triggered GPI is driven by external equipment that generates one pulse per event. 

Level triggers are used when you want to assert a particular state for a setting. You define the on-air state of the 
function as being either Level High or Level Low. Therefore, if the on-air state of the Key is defined as Level High 
for example, when the GPI is a Level High signal, the Key will stay on air. If a Level Low is received, the Key will 
be taken off air.

• If configured for Active Low, the selected function is executed when the GPI input signal is driven Low.

• If configured for Active High, the selected function is executed when the GPI input signal is driven High.

Configuring a Port as a GPI

Each GPI can be configured independently from the others, allowing you to customize the function of each 
connection.

To configure a port as a GPI

1. Navigate to the Configuration interface as outlined in the procedure “To display the Configuration interface 
in DashBoard” on page 29.

2. Select the GPI/Tally tab.
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3. Use the Function menu to assign a transition event to a specific GPI port.

4. Use the Trigger/Tally Type menu to select a trigger and polarity for the GPI.

Tally Communication Setup

When configured as a Tally, a port becomes an output, providing a status indicator. Typically this is used to indicate 
which input(s) are on-air at any given moment. Each tally output on the card can be configured to be active when 
any of the four inputs are on air. They can be configured as Active High or Active Low. Edge triggered tallies 
generate a pulse to the configure polarity (high or low) for a duration of 30 frames or the duration of the event 
(whichever is shorter). The tally outputs defaults to a logical high level when inactive. When the tally becomes 
active, for example the signal is on-air, then the output is driven low.

To configure a port as a tally

1. Navigate to the Configuration interface as outlined in the procedure “To display the Configuration interface 
in DashBoard” on page 29.

2. Select the GPI/Tally tab.

3. Use the Function menu to specify what will drive the tally output when the input is on-air.

4. Use the Trigger/Tally Type menu to select the polarity of the tally.
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Keying
Keying is the term used to described the inserting (or electronically cutting) portions of one screen into another, or 
placing titles over background images. Keys are made up of two components: an alpha (that cuts the hole in the 
background video), and a fill (that fills the hole with different video). This chapter summarizes the GATOR-KEY 
keying features and configuration options.

Overview

The GATOR-KEY includes up to four high quality UHD/3G/HD-SDI video keyers. In addition to the external Key 
Video and Key Alpha source, there are also two internal static/animation playout channels. This enables the keying 
of external devices such as character generators or graphic systems into a program feed and/or keying with four 
internal logo channels.

Key Types

The GATOR-KEY supports the following key types.

Auto Select

An Auto Select Key uses two video signals: the Key Alpha is used to cut the hole in the video, and the Key Video is 
used to fill the hole. For external keying, use the Configuration > External Key options to configure the two 
external keys. For internal sources, the Key Video and Alpha are generated internally. Note that the Key Alpha Type 
is automatically set to Shaped.

Self

A Self Key uses only one video signal: the luminance (or brightness) of the Key Video is used as the Key Alpha. 
For external keying, use the Configuration > External Key options to configure the two external keys. For internal 
sources, the Key Video is internally supplied. Note that the Key Alpha Type is automatically set to Unshaped.

Key Alpha Types

You can specify a key alpha as one of the following types.

Unshaped (multiplicative keying)

With an Unshaped Key, the Key Alpha luminance value mixes linearly the Key Video with the Background. Shades 
of gray, in the Key Alpha, are translated into transparency levels, giving the key a soft edge. Self Keys are set to 
Unshaped by default.

Shaped (additive keying)

With a Shaped Key, the Key Alpha cuts a hole in the Background based on the luminance value of the Key Alpha 
and adds the Key Video to the Background hole. Shaped Key alphas are sometimes used with Character Generators 
to cut very precise holes for the Key Video fill. Auto Select keys are set to Shaped by default.

Configuring Key Sources

You can assign any of the logo channels as the source for a keyer. The GATOR-KEY offers full key control with 
shaped and unshaped keying, self key or auto key, with clip and gain control.
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To set the key type

1. Navigate to the On Air Control interface as outlined in the procedure “To display the On Air Control 
interface in DashBoard” on page 30.

2. Select the Keyers tab.

3. Select the sub-tab for the key you wish to configure.

4. Set the Key Type by toggling the Key Type button.

• Auto Select— If the button displays this label, the Key uses the specified SDI IN signal on the rear module 
as the Key Video and the specified SDI OUT signal as the Key Alpha when Key Video is used for the key 
source. The Key Alpha Type is now set to Shaped.

• Self — Select this option to use the SDI IN signal on the rear module as the Key Video, when Key Video is 
selected for the key source on the On Air tab, and its own luminance value of the same video as the Key 
Alpha. The Key Alpha Type is now set to Unshaped.

5. If required, use the Key Alpha Type menu to specify the Key Alpha Type.

Configuring the External Keys

GATOR-KEY enables you to assign a different alpha source for an external key than the fill/alpha assigned by a 
specific SDI IN signal.

 You can also assign a matte generator as an external key source which may be useful for testing purposes.

For More Information on...

• assigning a matte generator to an external key, refer to the section “Assigning a Matte Generator to an 
Output” on page 43.

To assign a source to an external key

1. Navigate to the Configuration interface as outlined in the procedure “To display the Configuration interface 
in DashBoard” on page 29.

2. Select the External Keys tab.
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3. Use the Video Source menu to select a source for the specified external key.

4. Use the Alpha Source menu to select a different alpha for the specified external key. 
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Mattes
Mattes are solid color signals that can be applied to backgrounds and keys. A matte is like a pattern wash, but has 
only one color. A matte can be applied to an external key or card output. 

Setting up a Matte Color

Color selection is done by adjusted hue, saturation, and luminance to create a custom color. The full region of the 
background or key is filled with the selected color. 

To set up a matte color

1. Navigate to the Configuration interface as outlined in the procedure “To display the Configuration interface 
in DashBoard” on page 29.

2. Select the Matte tab.

3. Select the sub-tab for the matte generator you want to configure.

4. Use the Luma slider to adjust the luminance of your matte color.

5. Use the Cr slider to adjust the hue of your matte color.

6. Use the Cb slider to adjust the saturation of your matte color.

7. Repeat steps 3 to 6 for each matte generator you require.

Assigning a Matte Generator to an Output

Mattes can be applied by selecting the matte generator (Matte #) on a background or key bus. When a matte 
generator is assigned to an external key or card output, the matte settings are displayed. 

Matte generators 1 and 2 are available as background and external key sources. Matte generators 3 and 4 are 
available as video outputs.
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To assign a matte generator to a video output

1. Navigate to the Configuration interface as outlined in the procedure “To display the Configuration interface 
in DashBoard” on page 29.

2. Select the Output Selection tab.

3. Use the required Output drop-down menu to assign Matte 3 or Matte 4 to the required output of the card.

To assign a matte generator to an external key

1. Navigate to the Configuration interface as outlined in the procedure “To display the Configuration interface 
in DashBoard” on page 29.

2. Select the External Keys tab.

3. Use the Video Source menu to assign Matte 1 or Matte 2 as the video source for the specified external key.

4. Use the Alpha Source menu to assign Matte 1 or Matte 2 as the alpha source for the specified external key. 
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Transitions
Transitions are used to change the background video and take keys on and off-air. A transition can include any 
combination of Background video, and keys. The Program and Preset inputs allows for background dissolves and 
V-Fades behind the external key source.

Before You Begin

Keep the following in mind when performing transitions:

• To allow for audio cross fading, a cut takes two frames. One frame is used for the audio fade down, the video is 
then cut, followed by the one frame audio fade up.

• The speed at which the transition is performed, in number of frames, is determined by the setting (Slow, 
Medium, or Fast) in the Transition Rate area. Before proceeding, ensure the Transition Type is set to the desired 
type.

• If a crosspoint or transition button is selected while a transition is in progress, the original transition continues as 
subsequent button presses are ignored (except the FTB button).

Configuring the Transition Buttons

The Configuration interface in DashBoard enables you to specify how the TAKE button, in the On Air Control tab, 
behaves when toggled during a transition. 

To configure the TAKE button

1. Navigate to the Configuration interface as outlined in the procedure “To display the Configuration interface 
in DashBoard” on page 29.

2. Select the Transitions tab.

3. Configure the TAKE button behavior by choosing an option from the Take During Transition Action area. 
Choose from the following:
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 The selected behavior also applies to GPIOs.

• Ignore — Select this option to disregard any successive presses of the Auto button until the transition is 
complete.

• Pause — Select this option to pause the transition when the Auto button is toggled, and resume the transition 
when the button is pressed again. This is the default setting.

• Reverse — Select this option to reverse the transition back to the start.

Specifying a Transition Rate

You can independently define the Fade to Black, Slow, Medium, and Fast transition rates, in number of frames.

To set a transition rate

1. Navigate to the On Air Control interface as outlined in the procedure “To display the On Air Control 
interface in DashBoard” on page 30.

2. Select the Home tab.

3. Specify the rate, in number of frames, as required in the Slow Rate, Medium Rate, and Fast Rate fields.

4. Use the FTB Rate field to specify the Fade to Black transition rate.

Post Transition Behavior

You can specify the behavior of the Program and Preset buses after a transition.

To specify the post transition behavior

1. Navigate to the Configuration interface as outlined in the procedure “To display the Configuration interface 
in DashBoard” on page 29.

2. Select the Transitions tab.

3. Choose one the following Post Transition Behavior options:

• Leave Preset As Is — The Preset bus is unchanged after a transition. Preset keyers follow Program keyers on 
hot-punches.

• Swap Program/Preset — The selections for the Program and Preset swap in anticipation of the next 
transition.
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• Preset Off — The keyers on the Preset bus will be turned off automatically after a transition. The operator 
must manually select the keyer(s) to be included in the next transition.

Performing Transitions

You can perform transitions in one of the following manners:

• hot-punching a crosspoint on the Program or Preset bus

• selecting a Keyer button from the Keyer area to transition a keyer on/off air

• using the options in the Transition area to add elements to the transition

The speed at which the transition is performed, in number of frames, is determined by the Transition Rate (Slow, 
Medium or Fast) set in the Home > Transition Rate menus. 

To perform a Cut transition on the Program bus

1. Navigate to the On Air Control interface as outlined in the procedure “To display the On Air Control 
interface in DashBoard” on page 30.

2. Select a button on the Program bus.

To perform a Cut transition for a Key

1. Navigate to the On Air Control interface as outlined in the procedure “To display the On Air Control 
interface in DashBoard” on page 30.

2. Select a source for the Program output from the desired Key Source menu.

3. Select CUT. 

The Key is transitioned on or off air.

The Key Status field(s) indicates the on-air status of the key.

To perform a Take transition

1. Navigate to the On Air Control interface as outlined in the procedure “To display the On Air Control 
interface in DashBoard” on page 30.

2. Select the Key 1-4 buttons to add the required keyer(s).

3. Select a Transition Speed button (Slow, Medium, or Fast).

4. Select a Transition Type button.

5. Select Take.

Performing a Fade to Black

The FTB button performs a fade to black where the:

• Program bus is faded to black at the FTB rate,

• audio goes to silence, and

• closed captioning information is not passed.

The Fade to Black rate is set in the Home tab as outlined above. When the FTB button is selected, or lit, the 
GATOR-KEY performs an Auto transition to black.

To perform a fade to black

1. Navigate to the On Air Control interface as outlined in the procedure “To display the On Air Control 
interface in DashBoard” on page 30.

 If the Fade Down/Fade Up button is selected while a Fade to Black is in transition, the Fade will reverse.
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2. Toggle the FTB button as follows:

• Fade Down — When the button displays this label, clicking it performs an Auto transition to black. The rate 
is determined by the rate set in the Home > FTB Rate menu.The button label changes to Fade Up. 

• Fade Up — When the button displays this label, clicking it performs an Auto transition from black. The rate 
is determined by the rate set in the Home > FTB Rate menu.The button label changes to Fade Down.
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Media File Management
DashBoard enables you to select and configure the two Logo channels that are loaded in the GATOR-KEY. Each 
Logo channel has a sub-tab that enables you to assign a media file to the specified logo, view a thumbnail that 
represents the media file currently loaded, and adjust on-air properties.

 The procedures in this chapter assume the On Air Control interface is displayed in the DashBoard window.

Before You Begin

The following tips and restrictions apply when managing your media files:

• Media files, such as stills and animations, are transferred to and from the GATOR-KEY using FTP protocol. The 
media files are stored on the Micro SD card that is installed on the GATOR-KEY.

• If you select an image size that is larger than the current video format, or an image that is positioned so that a 
portion of the image is off screen, this may corrupt the video output.

• When using Mac OS X™ to transfer files to the Micro SD card via an FTP server, you may only have read-only 
access. Refer to your Mac OS X™ documentation for details.

Managing your Media Files

The GATOR-KEY features two Logo channels (Logo 1, 2) into which you can load files from the Micro SD card 
physically installed on the Micro SD card. Each GATOR-KEY has 2GB of DDR playout memory. Table 14.1 lists 
an estimation of how many uncompressed frames can fit into the playout memory of the GATOR-KEY.

 Very large animations may take several minutes to load.

Media files, such as animations and still images, can be transferred to and from the Micro SD card using an FTP 
connection. Once transferred to the Micro SD card, you use the options in the Logo tab to load the files and assign 
them to a Logo channel.

This section outlines the specifications for media files and provides general information on using the Micro SD card 
and an FTP connection.

For More Information on...

• assigning media files to Logo channels, refer to the section “Loading a Media File” on page 51.

Image Specifications

Media files used on the GATOR-KEY must meet the specifications outlined in Table 14.2. Note that if larger 
images are used, the images will be clipped to the dimensions listed in Table 14.2.

Table 14.1  Full Frame Animation

Format Image Size No Alpha With Alpha

2160p 3840x2160 88 58

1080i 1920x1080 386 256

1080p 1920x1080 386 256

720p 1280x720 870 579
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File Naming Specifications

Keep the following in mind when naming your media files:

• The name can contain letters, numbers, and spaces, but cannot contain symbols such as ! @ # & * ( ) ? / , ‘ “.

• If you are naming an animation, each file must be numbered in the sequence that it will play out. The following 
restrictions apply to file names for animations:

› Each file can use a minimum 3-digit number, including all the leading zeros.

› The file name and number must be separated by an _ followed by three or more digits, then a period (.).

› Each file in the sequence must have the same numbering scheme.

› The GATOR-KEY loads files in numerical order.

The following is an example of a 10-frame animation using a typical numbering scheme:

DTVB_000.tga

DTVB_001.tga

...

DTVB_009.tga

Connection using FTP

You can use an FTP connection to transfer media files to and from the Micro SD card of the GATOR-KEY. You can 
also use an FTP client to delete images on the Micro SD card and re-name images.

 An FTP connection to the GATOR-KEY should be established by your IT Department. 

Before accessing the GATOR-KEY via FTP:

1. Ensure that you know the IP Address of the GATOR-KEY. This information is available in the Global > 
Network tab.

2. Ensure an ethernet cable is connected to the GATOR-KEY via its Ethernet port on the rear module. Refer to the 
section “GATOR-KEY Rear Module Overview” on page 16 for the port location.

3. Provide the following information to your IT Department:

• User Name — user

• Password — password

Table 14.2  Image Specifications

Parameter Specification

Supported File Types BMP, GIF, JPEG, PNG, TGA

Compression Compressed and uncompressed

Interlace Formats Max. Image Width: 32,768 pixels

Max. Image Height: dependent on available memory

Progressive Formats Max. Image Width: 65,536 pixels

Max. Image Height: dependent on available memory

Animation Maximum Length 10,000 frames
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Connection using RossLinq

RossLinq enables you to transfer still images directly from the XPression to a GATOR-KEY Logo channel. You can 
transfer files into any of the directories for any of the Logo channels on the card. There are four directories, each 
corresponding to a specific Logo channel on the card. The file can be a format as listed in Table 14.2. Note that the 
transfer of animations is not supported at this time.

To connect to the XPression via RossLinq, establish an FTP connection using the following information:

 The RossLinq channel in XPression must be set as a passive FTP connection in order to set up communications 
between XPression and the GATOR-KEY. Refer to the XPression documentation for details.

• IP Address — This information is displayed in the IP Address field of the Ethernet tab in DashBoard for 
your card.

• User Name — xpression

• Password — password 

For More Information on...

• using XPression, refer to the XPression User Guide.

Using the Micro SD Card

The following tips and restrictions apply when using the Micro SD card:

• the Micro SD card must be installed on the GATOR-KEY powers up and must remain inserted.

• if you wish to remove the Micro SD card for programming, you must re-boot the GATOR-KEY when you 
re-install the Micro SD card. This allows the GATOR-KEY to recognize that a new card is available.

• the number of files you can store depends on the type of file (PNG, TGA, JPG). The Micro SD card Status field 
in the On Air Control > Logo > Logo # tab reports how much space is available on the Micro SD card.

Loading a Media File

When a media file is loaded, metadata, such as X/Y position, is also loaded, if it exists. Otherwise, default values 
are used. For animations, parameters are recalled after the last frame is loaded.

To load a media file into a Logo channel

1. Navigate to the On Air Control interface as outlined in the procedure “To display the On Air Control 
interface in DashBoard” on page 30.

2. Select the Logo tab.

3. Select the sub-tab for the Logo channel you want to load the media file for.

4. If files were added or re-named using an FTP connection, click Rescan to update the list of directories and 
filenames in the tab menus.
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5. From the Directory menu, select the directory you wish to load a file from. Choose from the following:

• [RAM CACHE] — A virtual directory that displays media files that are already loaded in the playout 
memory. Selecting this directory enables you to quickly access a pre-loaded file from the memory.

• [ROOT] — This is the default directory and represents the top-most directory on the Micro SD card. You 
can manage files on the Micro SD card using an FTP connection.

6. From the Filename menu, select the file. 

 You can clear space in the image cache by selecting None from the Filename menu of any Logo channel. 
However, doing so immediately replaces the current media file with the file you are attempting to load.

Adjusting On-Air Properties

The Logo tab in DashBoard allows you to adjust the position and play modes of media files. Parameters that are 
adjusted are saved with the image/animation. When a logo/animation is subsequently re-loaded, these parameters 
are also recalled. However, if there are no saved parameters for a recalled logo/animation, then the parameters 
remain unchanged.

To adjust the on-air properties of a media file

1. Load a media file as outlined in the procedure “To load a media file into a Logo channel”.

2. Adjust the position of a still image in the viewing area of the screen using the X and Y Position sliders.

 You cannot position any portion of an image off-screen and full images cannot have their position adjusted.

3. Use the Auto Play box to set whether the animation automatically starts to play when it is taken on-air.

• When this feature is enabled, the animation will play from the first frame when it is brought to air.

• When this feature is disabled, the animation to air does not affect playback.

4. Use the Looping box to set whether the animation will start over when it reaches the last frame of the 
animation.

• When this feature is enabled, the animation will cycle continuously (from the last frame back to the first) in 
an endless loop.

• When this feature is disabled, the animation plays once, and freezes on the last frame.

When both Auto Play and Looping are enabled, the animation begins to play on a transition, and keeps playing in 
an endless loop. If another transition is triggered, the animation jumps to the first frame and keeps playing in an 
endless loop.

5. Use the Hold Time menu to add a pause between loops of an animation.

When this feature is enabled, the animation will play, but before looping back (if looping is enabled), it pauses on 
the last frame, for the specified Hold Time (in number of frames).

6. Select how an image is displayed by selecting an option from the Play Mode menu. 

 The Play Mode feature only applies to Interlaced video formats and has no effect when using Progressive video 
formats.
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Using RossTalk
 The GATOR-KEY can be controlled from a remote editor or computer via RossTalk commands. These commands 
can be sent to the GATOR-KEY over an ethernet connection (TCP/UDP).

Establishing a Connection between GATOR-KEY and an External Device

Contact your IT Department before connecting to your facility network to ensure that there are no conflicts. They 
will provide you with an appropriate value for the IP Address, Subnet Mask, and Gateway for the GATOR-KEY 
and your third-party router.

Physical Connection

You will require a standard network CAT-5 cable to connect the GATOR-KEY to your facility network. Refer to the 
section “Cabling the Ethernet Port on the Frame” on page 23 for more information.

Configuring the GATOR-KEY for RossTalk Communications

This section outlines how to configure the GATOR-KEY to communicate with a device via RossTalk.

For More Information on...

• the RossTalk settings on the Remote Control tab, refer to Table 17.13.

To enable the RossTalk protocol

1. Navigate to the Configuration interface as outlined in the procedure “To display the Configuration interface 
in DashBoard” on page 29.

2. Select the Remote Control tab. 

3. Locate the RossTalk row in the Ethernet Port area of the tab.

4. From the Protocol menu, select the ethernet protocol your device will use to communicate with the card.

5. Ensure the Port field is set to 7788.

6. Select the RossTalk Enabled box.
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Using the RossTalk Protocol

RossTalk is a plain text based protocol that allows control of Ross Video equipment.

Sending RossTalk Commands

RossTalk commands are generally case-sensitive, and must be terminated with carriage return and linefeed 
(CR+LF). When using with the GATOR-KEY, the command can be uppercase or lowercase, and the terminator can 
by simply linefeed.

For example,

MSPATH 1:0:ColorRamp.tga

MSPATH 1:0:directory/filename.png

To send RossTalk Commands

1. Verify that you have created a network connection to the GATOR-KEY. 

2. Enter the commands you want to send to the GATOR-KEY.

Supported RossTalk Commands

Table 15.1 lists the RossTalk commands that the GATOR-KEY supports.

Table 15.1  Supported RossTalk Commands

Command Description

FTB Performs a fade-to-black transition

FTB level • Level 0 = always clears FTB. No impact if already FTB

• Level 1 = always sets FTB state. No impact if already FTB

GPI xx Triggers action associated with GPI number 1 through 4

GPI xx:level Triggers GPI number 1 to 4 where:

• Level 0 = logically OFF

• Level 1 = logically ON

KEYAUTO 1:keyer Fades a key on/off air. The keyer value is 1 to 4.

KEYAUTO 1:keyer:level • Level 0 = always take key off air; no change if key is already 
off air

• Level 1 = always take key on air; no change if key is already 
on air

KEYCUT 1:keyer Cuts a key on/off air. The keyer value is 1 to 4.

KEYCUT 1:keyer:level • Level 0 = always take key off air; no change if key is already 
off air

• Level 1 = always take key on air; no change if key is already 
on air

MSPATH CHAN:0:FILENAME Load a still or animation from the Micro SD card where:

• CHAN is logo channel (1 to 2)

• FILENAME is the directory/filename to be loaded. There is a 
maximum filename length of 256bytes.

 The FILENAME is case-sensitive and must match exactly 
how the files are stored on the Micro SD card.
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Upgrading the Software
The GATOR-KEY can be upgraded in the field via DashBoard.

To upgrade the software on a card

1. Contact Ross Technical Support for the latest software version file.

2. Ensure the ethernet cable is connected to the Ethernet port on the OG3-FR series frame.

3. From the Tree View, expand the node for the GATOR-KEY you want to access.

4. Double-click the Global sub-node to display the interface in the right-half of DashBoard.

5. Select Upload, located near the bottom of the interface, to display the Select file Upload dialog. 

6. Navigate to the *.bin file you want to upload.

7. Click Open.

8. If you are upgrading a single card:

a. Click Finish to start the upgrade.

b. Proceed to step 10.

9. If you are upgrading multiple cards:

a. Click Next > to display the Select Destination menu. This menu provides a list of the compatible cards.

b. Specify the card(s) to upload the file to by selecting the check box(es) for the cards you want to upload the 
file to.

c. Verify the card(s) you want to upload the file to. The Error/Warning fields indicate any errors, such as 
incompatible software or card type mismatch.

d. Click Finish.

10. Monitor the upgrade.

• An Upload Status dialog enables you to monitor the upgrade process.

• Notice that each card is listed in the dialog with a  button. This button is replaced with a Reboot button 
once the software file is loaded to that card.

 Avoid clicking the individual Reboot buttons until all cards have successfully completed the file upload process 
and the OK button, located in the bottom right corner of the dialog, is enabled.

• Click OK to reboot all the cards listed in the Uploading to Selected Devices dialog.

• The Reboot Confirm dialog displays, indicating the number of cards that will reboot. Click Yes to continue 
the upgrade process. Note that clicking Cancel or No returns you to the Uploading to Selected Devices 
dialog without rebooting the card(s).

• The card(s) are temporarily taken off-line during the reboot process. The process is complete once the status 
indicators for the Card State and Connection return to their previous status.
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DashBoard Interface Overview
This chapter summarizes the interfaces, and tabs available from DashBoard for the GATOR-KEY.

Global Interface

The Global interface is displayed by double-clicking the Global sub-node in the GATOR-KEY tree. The tabs in the 
Global interface enable you to monitor the overall status of the GATOR-KEY software and hardware, configure the 
network settings for ethernet communications, and enable alarms.

Figure 17.1  Example of the Global Interface in DashBoard

Signal Tab

Table 17.1 summarizes the read-only information displayed in the Signal tab. 

Table 17.1  Signal Tab

Item Parameters Description

Analog Reference 
Status

Reference (Green) Indicates the detected reference format is 
supported

No Reference (Red) No signal detected on selected reference input

Incompatible (Red) A reference signal is detected but the format is 
incompatible with the current output mode

Unlocked (Red) A reference signal is detected, but the card is not 
locked to it

Analog Reference 
Format

### Indicates the reference format detected

INPUT #

Input Format ### Signal present and the format matches the video 
output format configuration of the card
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Product Tab

Table 17.2 summarizes the read-only information displayed in the Product tab.

Hardware Tab

Table 17.3 summarizes the read-only information displayed in the Hardware tab.

Input Audio Status 1# 2# 3# 4# Displays the audio status for each of the four audio 
groups where 1-4 indicates the group and # 
indicates the status of the group as follows: 

• an s indicates the presence of synchronous audio 
on the group

• an x indicates that audio is not present

• an a indicates the presence of asynchronous 
audio on the group

Table 17.2  Product Tab

Item Parameters Description

Product GATOR-KEY

Supplier Ross Video Ltd.

Board Rev # Indicates the hardware version

Serial Number # Indicates the serial number of the card

Rear Module # Indicates the rear module the card is installed in

Rear Module Status OK (Green) A supported rear module is installed with the card

Alarm suppressed (Green) An unsupported rear module is installed by the 
Global Alarm Enables > Incompat Rear Module 
option is disabled (box is not selected)

Incomp I/O Module (Red) Card is connected to an unsupported rear module

Software Rev v#.#-# Indicates the software version running on the card

Firmware Rev #.# Indicates the firmware version running on the card

CPLD Rev #.# Indicates the complex programmable logic device 
version of the GATOR-KEY

Daughter Board # Indicates the daughter card model installed on the 
main card

Table 17.3  Hardware Tab

Item Parameters Description

Hardware Status OK (Green) The fans are operating correctly and no errors are 
detected

Alarm suppressed (Green) There are fan errors detected but the Global Alarm 
Enables > Stalled Fan option is disabled (box is not 
selected)

Table 17.1  Signal Tab

Item Parameters Description
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Setup Tab

Table 17.4 summarizes the options in the Setup tab.

Hardware Status Critical Temperature (Red) An error with the fans is occurring. Verify that the 
fans and airflow for the card is valid.

Fan Off/Stalled (Red)

Voltage (mV) # Measured input voltage

Current (mA) # Current consumption in milliamperes

Power (W) # Power consumption in watts

FPGA Temp (C) #C / #F Indicates the FPGA Core temperature where:

• A green indicator displays when the temperature 
is less than 95°C.

• A yellow indicator displays when the 
temperature is greater than or equal to 95°C.

• A red indicator displays when the temperature is 
greater than or equal to 100°C.

If the temperature is greater than 100°C, the 
user must manually shut off the card.

AXI Bridge # The Advanced extensible interface bridge is 
running correctly on the GATOR-KEY. This 
information is only used by Ross Technical 
Support.

Fan Speed # Reports the speed (rpm) of the fan on the board

CPU Usage x.xx / y.yy / z.zz Displays the CPU Load average where:

• x.xx represents in the last minute

• y.yy represents the last five minutes

• z.zz represents the last fifteen minutes

RAM Available # / #.## MB CPU Memory Used / Total CPU Memory

Table 17.4  Setup Tab

Item Parameters Description

Analog Reference 
Source

Frame 1 Select this option to use the source connected to 
the REF 1 port on the openGear frame

Frame 2 Select this option to use the source connected to 
the REF 2 port on the openGear frame

Local Select this option to use the external reference 
source connected to REF IN on the rear module

Factory Defaults

Load Factory Defaults All editable parameters in DashBoard, except those in the Network tab, are reset to 
the factory default values

Table 17.3  Hardware Tab

Item Parameters Description
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Network Tab

Table 17.5 summarizes the menus and read-only fields displayed in the Network tab.

Table 17.5  Network Tab

Item Parameters Description

Remote Logging

Remote Logging #.#.#.# Specifies the IP Address for the external device 
that is logging the communication activity for the 
GATOR-KEY

Default Gateway

Current (read-only) #.#.#.# Indicates the gateway for communications outside 
of the local area network (LAN) 

Static Gateway #.#.#.# The Gateway for the GATOR-KEY that the user 
manually assigned

openGear Chassis RJ-45

Link Status (read-only) OK (Green) The GATOR-KEY is communicating on the 
network via the Network Controller Card

Invalid Subnet Mask 
(Yellow)

The Current Subnet Mask value is set incorrectly 
or is invalid within your network

Apply/Cancel Changes 
(Yellow)

One or more setting on this tab was changed but 
the Apply button was not selected

Link Down (Red) The link for the Network Controller Card is invalid

Current IP Address 
(read-only)

#.#.#.# Indicates the IP Address currently assigned to the 
GATOR-KEY via the Network Controller Card

Current Subnet Mask 
(read-only)

#.#.#.# Indicates the subnet mask for the GATOR-KEY

MAC Address 
(read-only)

# Indicates the MAC Address currently assigned to 
the GATOR-KEY

Mode Static The user manually supplies the network settings 
for the GATOR-KEY

DHCP* Automates the assignment of network settings for 
the GATOR-KEY

Static IP Address # The IP Address for the GATOR-KEY that the user 
manually assigned

Subnet Mask # The Subnet Mask for the GATOR-KEY that the 
user manually assigned
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Global Alarm Enables Tab

Table 17.6 summarizes the options displayed in the Global Alarm Enables tab.

Configuration Interface

The Configuration interface is displayed by double-clicking the Configuration sub-node in the GATOR-KEY tree. 
The tabs in the Configuration interface enable you to configure the outputs, external keys, transitions, the matte 
generators, the box masks, and GPI/Tally communications.

Figure 17.2  Example of the Configuration Interface in DashBoard

Table 17.6  Global Alarm Enables Tab

Item Parameters Description

Rear Module Alarm

Incompat Rear Module Selected* The Global > Product > Rear Module Status field 
reports when a rear module is not compatible with 
the card

Cleared Disables this alarm

Fan Alarm

Stalled Fan Selected* The Global > Hardware > Hardware Status field 
reports when the indicated fan is not working 
correctly

Cleared Disables this alarm

Analog Reference Alarm

Reference Error Selected* The Global > Signal > Analog Reference Status 
field reports when there is a loss of reference 
signal

Cleared Disables this alarm
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Video Format Tab

Table 17.7 summarizes the read-only information displayed in the Video Format tab.

External Keys Tab

Table 17.8 summarizes the options displayed in the External Keys tab.

Table 17.7  Video Format Tab

Item Parameters Description

Output Format

Output Format # Selects the video format for the output signal. Note 
that a change in video format will not take effect 
until the reference is compatible.

The default is 1080p/59.94.

Clip at Black Selected Enables the card to clip to SMPTE black on all 
outputs

Cleared Super-black is not clipped (allows super-black)

Clip at White Selected Enables the card to slip to SMPTE white on all 
outputs

Cleared Super-white is not clipped (allows super-white)

Input Status - Input #

Status (read-only) OK (Green) The input signal is valid and no errors are detected

Incompatible Video (Yellow)

Invalid Video (Red) The input video format is not supported or does not 
match the reference format

No signal (Red) No signal present on the specified input

Format (read-only) # Indicates the detected video format of the specified 
input signal

Timing (read-only) # lines (to analog ref) Indicates the timing of the specified input signal 
relative to the reference signal

Alarm Enables Selected* The GATOR-KEYmonitors the signal on the 
specified IN BNC and reports when an error is 
detected on the input signal

Cleared The GATOR-KEYdoes not report when an error is 
detected on the specified input signal

Table 17.8  External Keys Tab

Item Parameters Description

Video Source

External Key # Black Assigns black as the video source for the specified 
External Key

White Assigns white as the video source for the specified 
External Key

Matte # Assigns the specified matte generator as the video 
source for the specified External Key
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Transitions Tab

Table 17.9 summarizes the options displayed in the Transitions tab.

Output Selection Tab

Table 17.10 summarizes the options displayed in the Output Selections tab.

External Key # Input # Assigns the specified SDI IN signal as the video 
source for the specified External Key

Alpha Source

External Key # Black Assigns black as the alpha source for the specified 
External Key

White Assigns white as the alpha source for the specified 
External Key

Matte # Assigns the specified matte generator as the alpha 
source for the specified External Key

Input # Assigns the specified SDI IN signal as the alpha 
source for the specified External Key

Table 17.9  Transitions Tab

Item Parameters Description

Post Transition Behavior

Leave Preset As Is* The Preset bus remains unchanged after a transition

Swap Program/Preset The Program and Preset buses flip-flop after a transition

Preset Off The Preset bus is unavailable after a transition

Take During Transition Action

Ignore* Select this option to disregard any successive presses of the TAKE button until the 
transition is complete

Pause Select this option to pause the transition when the TAKE button is toggled, and 
resume the transition when the button is pressed again

Reverse Select this option to reverse the transition back to the start

Table 17.10  Output Selection Tab

Item Parameters Description

Output # Black The specified OUT BNC displays black

White The specified OUT BNC displays white

Matte # The specified OUT BNC displays the specified 
Matte channel

Program The specified OUT BNC displays the Program 
output

Preset The specified OUT BNC displays the Preview 
output

Table 17.8  External Keys Tab

Item Parameters Description
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Matte Tab

Table 17.11 summarizes the options displayed in the Matte tab for each matte generator.

GPI/Tally Tab

Table 17.12 summarizes the options displayed in the GPI/Tally tab.

Output # Clean # The specified OUT BNC displays the selected 
clean feed output

SDI # The specified OUT BNC displays the specified 
SDI input signal

Alpha # The specified OUT BNC displays the specified 
alpha channel of the currently loaded logo.

If the corresponding logo channel does not have an 
alpha, the OUT BNC outputs white.

Table 17.11  Matte Tab

Item Parameters Description

Matte #

Luma # Adjusts the luma component

Cr # Adjusts the blue-difference values of the matte 
generator channel where:

• Increasing the value causes the display color to 
become increasingly saturated with blue

• Decreasing the value de-saturates the blue color 
from the display color

Cb # Adjusts the red-difference values of the matte 
generator channel where:

• Increasing the value causes the display color to 
become increasingly saturated with red

• Decreasing the value de-saturates the red color 
from the display color

Table 17.12  GPI/Tally Tab

Item Parameters Description

GPI/Tally #

Function None The specified GPIO port is not configured and the 
GPI has no effect. The Trigger/Tally Type setting 
is ignored.

Tally Video Input # Configures the GPIO port as an output and reflects 
the on-air status of the specified SDI IN signal

Tally Key # Configures the GPIO port as an output and reflects 
the on-air status of the specified Key

Table 17.10  Output Selection Tab

Item Parameters Description
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Remote Control Tab

Table 17.13 summarizes the options displayed in the Remote Control tab.

Function Tally Any Key Configures the GPIO port as an output; the Tally is 
active when any of the Keys are on-air

GPI Auto Key # An auto transition is performed to bring the key 
on-air or off-air when this GPI input is triggered

GPI Cut Key A cut transition is performed on the specified Key 
when a trigger is received by that GPI input

GPI Take A Take transition is performed when a trigger is 
received by that GPI input

GPI Fade to Black A fade to black is performed when a trigger is 
received that the specified GPI input

Trigger/Tally Type Falling* If configured for Falling Edge, the selected 
function is executed when the GPI input signal 
transitions from High to Low

Rising If configured for Rising Edge, the selected 
function is executed when the GPI input signal 
transitions from Low to High

High If configured for Active High, the selected 
function is executed when the GPI input signal is 
driven High

Low If configured for Active Low, the selected function 
is executed when the GPI input signal is driven 
Low

Current State 
(read-only)

High Reports the tally status

Low

Table 17.13  Remote Control Tab

Item Parameters Description

Ethernet Port - RossTalk

Remote Control 
(read-only)

OK • Enabled box is selected for this protocol

• Role is set to Client 

• Specified IP address and Port number are valid

• GATOR-KEY has successfully established 
connection to the given IP address and port

Inactive (Green) Enabled box is not selected for RossTalk

Listening (Green) • Enabled box is selected for RossTalk

• Role is set to Server 

• Specified Port number is valid

• GATOR-KEY is ready to accept connections on 
the specified port

Table 17.12  GPI/Tally Tab

Item Parameters Description
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Remote Control 
(read-only)

Reconnecting (Yellow) • Enabled box is selected for RossTalk

• Role is set to Client 

• GATOR-KEY attempts to connect periodically 
to the specified IP address and Port number. The 
interval between connection attempts start at 10 
seconds, increases by 10 seconds, to a maximum 
of 60 seconds.

Connecting (Yellow) • Enabled box is selected for RossTalk

• Role is set to Client

• GATOR-KEY is attempting to connect to the 
specified IP address and Port Number

Port in use (Red) • Enabled box is selected for RossTalk

• Role is set to Server

• Port Number specified in the Port field is invalid 
or in use by another service

Cannot connect (Red) • Enabled box is selected for RossTalk

• Role is set to Client

• Specified IP address and Port Number are invalid 
or in use by another device

Enabled Selected Enables the RossTalk protocol on the rear module 
ethernet port

Cleared* Disables the RossTalk protocol on the ethernet 
port. When the check box is cleared, any incoming 
data from the external device is discarded by the 
GATOR-KEY.

Role Server The GATOR-KEY functions as a host, or socket 
listener, on the network

Client The GATOR-KEY functions as a service requester 
that initiates communications with a server

Protocol TCP* Select this option if your external device is 
connected to the GATOR-KEY through a network 
and uses the Transmission Control Protocol 
(TCP/IP)

UDP Select this option if your device is connected to the 
GATOR-KEY through a network and uses the 
User Datagram Protocol (UDP/IP).

Table 17.13  Remote Control Tab

Item Parameters Description
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On Air Control Interfaces

The On Air Control interface enables you to setup and perform transitions. This interface is organized into two 
distinct panels:

• Setup — This panel is located in the top half of the interface and includes the Home, Keyers, and Logo tabs.

• Control — This panel is in the lower half of the On Air Control interface and includes the Program and Preset 
buses, Keyers area, Transition area, and TAKE button.

Figure 17.3  Example of the On Air Control Interface

Port # When Role is set to Server:

• specifies the TCP or UDP port numbers where 
the GATOR-KEY will listen on.

• TCP ports 0, 21, 80, 5253, and 6667 are 
unavailable for ethernet communications

When Role is set to Client, this menu specifies the 
remote port number to which the GATOR-KEY 
will try to connect 

IP Address #.#.#.# • Only applicable when Role is set to Client 

• Specifies the IP address of the external device. 
The default is 0.0.0.0 and this must be changed 
to the actual IP address of the external device.

Table 17.13  Remote Control Tab

Item Parameters Description
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Home Tab

The Home tab is the first tab that displays in the Setup panel. Table 17.14 summarizes the options displayed in the 
Home tab.

Keyers Tabs

The Keyers tab is the second tab that displays in the Setup panel. Each keyer has a sub-tab that enables you to select 
video sources, key types, and adjust transparency, clip, and gain. The GATOR-KEY supports Auto Select and Self 
keys. Table 17.15 summarizes the options displayed in each Key sub-tab.

Table 17.14  Home Tab

Item Parameters Description

Transition Rates (frames)

Slow Rate 2 to 999a

a. The default value is 60 frames.

Defines the Slow Rate in frames

Med Rate 2 to 999b

b. The default value is 30 frames.

Defines the Medium Rate in frames

Fast Rate 2 to 999c

c. The default value is 15 frames.

Defines the Fast Rate in frames

FTB Rate 2 to 999d

d. The default value is 30 frames.

Defines the Bade to Black Rate in frames

Table 17.15  Keyers — Key # Tabs

Item Parameters Description

Transparency 0* to 100 Adjusts the transparency level of the key:

• 0 — The key is completely opaque; there is no 
difference between the original key and the key 
with the transparency effect applied to it.

• 100 — The key is completely transparent; the 
key is not visible on the screen.

Clip # Adjusts the clip values; default is 92% (the 
maximum luminance range not including Super 
White).

Gain 0 to 100 Adjusts the gain values; default is 50.

Key Type Auto Select* A Key which uses two video signals (Alpha and 
Fill); the Key Alpha Type is automatically set to 
Shaped. 

If you configure an internal Logo channel as Auto 
Select, the associated alpha signal is used.

Self A Key that uses the luminance values of the KEY 
VIDEO source for the alpha; the Key Alpha Type 
is automatically set to Unshaped.

If you configure an internal Logo channel as Self, 
the luminance value of the associated alpha is 
used.
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Logo Tabs

Each logo channel has a sub-tab that enables you to select files, position the on-screen image, and specify animation 
playout settings. Table 17.15 summarizes the options displayed in each Logo tab.

Key Alpha Type Unshaped* The card performs a multiplicative key. The Key 
Alpha luminance value mixes linearly the Key 
Video with the Background. Shades of gray, in the 
Key Alpha, are translated into transparency levels, 
giving the key a soft edge.

Shaped The card performs an additive key. The Key Alpha 
cuts a hole in the BKGD and the Key Video is 
added to the BKGD. Shaped Key alphas are 
sometimes used with Character Generators to cut 
very precise holes for the Key Video fill.

Key Invert On Reverses the polarity of the Key Alpha. A Key 
Invert can be applied to any key type.

Off* The Key Alpha is not inverted

Default Make Linear Resets the clip and gain values to the default 
settings. The default setting for this is Cleared 
(unselected).

Keyer Source

External # Assigns the external key source as the keyer output. You will also need to 
configure the settings in the External Sources tab

Logo # Assigns the specified Logo channel as the keyer output. 

Table 17.16  Logo — Logo # Tabs

Item Parameters Description

Image

File (read-only) xxx_##.yyy Indicates the full path of the currently loaded file 
where ## represents the duration of the file if it is 
an animation

Status (read-only) Loading frame X of Y • Displays information about the channel in both 
the number of frames (integer), and in the 
number of seconds (fractional)

• Any errors during loading are also displayed

• When the file(s) have loaded, this field displays 
the dimensions of the image (e.g. 1920x1080)

Animation loaded (#)

Single image loaded (#)

Idle

Queued Indicates that one logo channel is loading and a 
second channel was selected to load at the same 
time. Once the first channel is loaded, the second 
channel will begin loading.

Selected on (read-only) # Indicates all the key(s), or backgrounds, that 
currently have the media file selected 

None

Table 17.15  Keyers — Key # Tabs

Item Parameters Description
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On Air (read-only) # Indicates the on-air key(s), or backgrounds, that 
have this media file selected

Directory [RAM CACHE] The field displays the directory the currently 
selected media file is located in

[ROOT] Lists the directories on the Micro SD Card

Filename xxx.yyy

xxx_####.yyy

Displays the name of the selected media file.

Animation filenames include an underscore 
followed by three or more digits. The number of 
frames, and duration in seconds, is displayed in 
brackets after the filename.

Updated when a new Directory is selected in the 
Directory menu.

Provides a list of all the media files in the currently 
selected directory. Note that animations appear as a 
single entry.

[NONE] Selecting this option clears the logo channel. 

This item is automatically selected, without 
clearing the channel, when the user switches to a 
new directory

File List Rescan Pressing the button updates: the Directory menu 
options and the Filename menu options

SD Card Status 
(read-only)

x of #GB used Reports the amount of memory used on the Micro 
SD card

Mediastore Memory 
(read-only)

xMB of 2GB used Reports the amount of memory used by the 
Mediastore

Image Properties

X Position ## to ##a • Adjusts the position of the image along the 
X-axis in number of pixels

• The range varies depending on the output video 
format

Y Position ## to ##a • Adjusts the position of the image along the 
Y-axis in number of pixels

• The range varies depending on the output video 
format

Animation Properties

Auto Playb Selected* The animation starts to play when a transition 
occurs

Cleared The animation starts playing as soon as the 
animation is loaded to the bus

Table 17.16  Logo — Logo # Tabs

Item Parameters Description
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Control Panel

This area is used to select the video sources for each bus. Each crosspoint button will display the name of its source 
on the button face.

Figure 17.4  Example of the Control Panel

1. Program Bus

The Program Bus is used to select the video source that will display as the Background on the Program output.

2. Preset Bus

The Preset Bus is used to select the video source that displays on the Preview output.

3. Keyers Area

The Keyer Area enables you to add, or remove, keyers in transitions. This area includes the following controls:

The top row of buttons, labeled Key 1-4 and lit in red, are used to perform cuts on the specified keyer directly on 
the Program Bus, without affecting their inclusion in the next transition. A lit button indicates that the specified 
keyer is currently on-air.

The bottom row of buttons, labeled Key 1-4 and lit in blue, are used to add, or remove, the specified keyer to the 
next transition. Selecting the button toggles the keyer on/off and selects/removes the keyer to the Preset Bus 
respectively. Once the transition is executed, and depending on the Configuration > Transitions > Post Transition 
Behavior setting, the button(s) are no longer lit in this row but are lit red in the top row.

4. Transition Type Buttons

The following Transition Type buttons are available (from left to right):

›  (Cut) — Select this button to perform a cut transition from one source to the next.

Loopingc Selected* The animation starts over when it reaches the last 
frame of the animation

Cleared The animation stops when it reaches the last frame 
of the animation

Hold Timed # The animation plays but before looping back (if 
looping is enabled), it pauses on the last frame, for 
the specified number of frames.

a. The default value is 0 which represents the top-left corner of the active picture area.
b. This option is only applicable when an animation file is selected.
c. This option is only applicable when an animation file is selected.
d. The default value is 0.

Table 17.16  Logo — Logo # Tabs

Item Parameters Description
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›  (V-Fade) — Select this button to perform a V-Fade transition from the Program source to Black to the 

Preset source. The GATOR-KEY fades down from one source to black and then transitions to the next source. 
During a hot-punch transition, the video performs a CUT while the audio performs a V-Fade.

›  (Cut-Fade) — Select this button to perform a cut to black, then fade up to the next source.

›  (Cross Fade) — Select this button to perform a gradual fade from one source to the next. The 

GATOR-KEY performs a cross fade between sources. Note that this button is selected after performing a 
factory default reset.

›  (Fade-Cut) — Select this button to fade from one source to black and then cut to the next source.

5. Transition Speed Buttons

These buttons apply the rate (slow, medium, fast) to the next transition. The transition rates are specified in the 
Home tab.

 The Slow button is selected after performing a factory default reset.

 If you are controlling the GATOR-KEY via Automation, and these buttons are not lit, the transition rate applied 
is set by the Automation command. If you wish to apply one of these rates, remember to select the required 
transition speed button before performing a transition (e.g. selecting TAKE).

6. Transition Include Button

This button is used to add/remove the Preset source to/from the next transition. Toggling this button will 
immediately affect the video that is visible on the Preset output.

7. TAKE Button

Selecting the TAKE button performs the transition between the sources and effects selected in the Program and 
Preset buses, using the specified Transition Type and Transition Speed. 

8. FTB Button

Use this button to fade the Program bus to black. The Fade to Black (FTB) rate is specified in the Home tab. 
After performing a factory default reset, this button is toggled off (unlit).
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Technical Specifications
This chapter provides technical information for GATOR-KEY.

 Specifications are subject to change without notice.

Supported Video Formats

SDI Inputs Specifications

Table 18.1  Technical Specifications — Supported Video Formats

Resolution (lines) Frame Rate (Hz)

720p 50

59.94

1080i 50

59.94

1080p 50

59.94

2160p 50

59.94

Table 18.2  Technical Specifications — SDI Inputs

Item Specifications

Number of Inputs 4

Standards Accommodated 1.485Gbps Component, SMPTE 292M

2.97Gbps Component, SMPTE 424M

5.94Gbps Component, SMPTE 2081

11.88Gbps Component, SMPTE 2082

Impedance 75ohm

Return Loss >15dB to 1.485Gbps

>10dB to 2.97Gbps

>7dB to 5.94Gbps

>4dB to 11.88Gbps

Equalization (Belden 1694A cable) >220m (722ft) @ 1.485Gbps

>140m (459ft) @ 2.97Gbps

>50m (190ft) @ 11.88Gbps

Connection HD-BNC
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SDI Outputs Specifications

Environment

Power

Table 18.3  Technical Specifications — SDI Outputs

Item Specifications

Number of Outputs 4

Impedance 75ohm

Return Loss >15dB to 1.485Gbps

>10dB to 2.97Gbps

>7dB to 5.94Gbps

>4dB to 11.88Gbps

Signal Level 800mV ±10%

DC Offset 0V ±50mV

Rise and Fall Time (20-80%)

1.485Gbps: <270ps, <100ps difference

2.97Gbps: <135ps, <50ps difference

5.94Gbps: <80ps, <30ps difference

11.88Gbps: <45ps, <18ps difference

Jitter 1.485Gbps: <1.0UI jitter measured 10Hz-100kHz, <0.2UI 
above 100kHz

2.97Gbps: <1.0UI jitter measured 10Hz-100kHz, <0.3UI 
above 100kHz

5.94Gbps: <2.0UI jitter measured 10Hz-100kHz, <0.3UI 
above 100kHz, band limit @594MHz

11.88Gbps: <2.0UI jitter measured 10Hz-100kHz, 

<0.3UI above 100kHz, band limit @1188MHz

Overshoot <10% (11.88Gpbs: <15%)

Connection HD-BNC

Table 18.4  Technical Specifications — Environment 

Item Specifications

Maximum Ambient Temperature 40°C (104°F)

Table 18.5  Technical Specifications — Power

Item Specifications

Maximum Power Consumption 40W-80W (application dependent)
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Service Information
Routine maintenance to this openGear product is not required. In the event of problems with your card, the 
following basic troubleshooting checklist may help identify the source of the problem. If the frame still does not 
appear to be working properly after checking all possible causes, please contact your openGear products distributor, 
or the Technical Support department at the numbers listed under the “Contacting Technical Support” on page 12.

1. Visual Review — Performing a quick visual check may reveal many problems, such as connectors not 
properly seated or loose cables. Check the card, the frame, and any associated peripheral equipment for signs of 
trouble.

2. Power Check — Inspect the power indicator LED on the distribution frame front panel for the presence of 
power. If the power LED is not illuminated, verify that the power cable is connected to a power source and that 
power is available at the power main. Confirm that the power supplies are fully seated in their slots. If the 
power LED is still not illuminated, replace the power supply with one that is verified to work.

3. Input Signal Status — Verify that source equipment is operating correctly and that a valid signal is being 
supplied.

4. Output Signal Path — Verify that destination equipment is operating correctly and receiving a valid signal.

5. Unit Exchange — Exchanging a suspect unit with a unit that is known to be working correctly is an efficient 
method for localizing problems to individual units. 

Reloading the Software on the Card

In the unlikely event of a complete card failure, you may be instructed by a Ross Technical Support specialist to 
perform a complete software reload on the card.

To reload the software on the card

1. Eject the card from the frame.

2. Press and hold the Bootload button, while re-inserting the card into the frame.

3. Release the button.

• The OK/ERROR LED flashes green while the card is waiting for a new software load.

• If a new software load is not sent to the card within 60 seconds, the card will attempt to re-start with its last 
operational software load.

• Software loads can be sent to the card via the connection on the rear of the frame.

Warranty and Repair Policy

The GATOR-KEY is warranted to be free of any defect with respect to performance, quality, reliability, and 
workmanship for a period of FIVE (5) years from the date of shipment from our factory. In the event that your card 
proves to be defective in any way during this warranty period, Ross Video Limited reserves the right to repair or 
replace this piece of equipment with a unit of equal or superior performance characteristics.

Should you find that this card has failed after your warranty period has expired, we will repair your defective 
product should suitable replacement components be available. You, the owner, will bear any labor and/or part costs 
incurred in the repair or refurbishment of said equipment beyond the FIVE (5) year warranty period.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages 
(including loss of profits) incurred by the use of this product. Implied warranties are expressly limited to the 
duration of this warranty.

This User Manual provides all pertinent information for the safe installation and operation of your openGear 
product. Ross Video policy dictates that all repairs to the card are to be conducted only by an authorized Ross Video 
Limited factory representative. Therefore, any unauthorized attempt to repair this product, by anyone other than an 
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authorized Ross Video Limited factory representative, will automatically void the warranty. Please contact Ross 
Video Technical Support for more information.

In Case of Problems

Should any problem arise with your card, please contact the Ross Video Technical Support Department. (Contact 
information is supplied at the end of this publication.)

A Return Material Authorization number (RMA) will be issued to you, as well as specific shipping instructions, 
should you wish our factory to repair your card. If required, a temporary replacement frame will be made available 
at a nominal charge. Any shipping costs incurred will be the responsibility of you, the customer. All products 
shipped to you from Ross Video Limited will be shipped collect. 

The Ross Video Technical Support Department will continue to provide advice on any product manufactured by 
Ross Video Limited, beyond the warranty period without charge, for the life of the equipment.
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Software Licenses
This chapter provides third-party software license information for your GATOR-KEY. This product includes 
multiple software components which are individually licensed under one or more of the following licenses included 
in this chapter.

BSD

Copyright (c) 1991,1993, The Regents of the University of California. All rights reserved.

This code is derived from software contributed to Berkeley by Kenneth Almquist.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.

3. <BSD Advertising Clause omitted per the July 22, 1999 licensing change ftp://ftp.cs.berkeley.edu/pub/4bsd/README.Impt.License.Change> California, Berke-
ley and its contributors.

4. Neither the name of the University nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior 
written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 
NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CON-
SEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABIL-
ITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE.

Dual GPL

Portions of this software are copyright (C) 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

This project is also covered under the GPL v2.

GPL
GNU GENERAL PUBLIC LICENSE

Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By contrast, the GNU General Pub-
lic License is intended to guarantee your freedom to share and change all versions of a program--to make sure it remains free software for all its users. We, the Free 
Software Foundation, use the GNU General Public License for most of our software; it applies also to any other work released this way by its authors. You can apply 
it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distrib-
ute copies of free software (and charge for them if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces 
of it in new free programs, and that you know you can do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you have certain responsibilities if 
you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same freedoms that you received. You must 
make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License giving you legal permission 
to copy, distribute and/or modify it.

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this free software. For both users' and authors' sake, the GPL 
requires that modified versions be marked as changed, so that their problems will not be attributed erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the manufacturer can do so. This is funda-
mentally incompatible with the aim of protecting users' freedom to change the software. The systematic pattern of such abuse occurs in the area of products for indi-
viduals to use, which is precisely where it is most unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If 
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such problems arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the 
freedom of users. 

Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use of software on general-purpose 
computers, but in those that do, we wish to avoid the special danger that patents applied to a free program could make it effectively proprietary. To prevent this, the 
GPL assures that patents cannot be used to render the program non-free.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. Definitions.

"This License" refers to version 3 of the GNU General Public License.

"Copyright" also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.

"The Program" refers to any copyrightable work licensed under this License. Each licensee is addressed as "you". "Licensees" and "recipients" may be individuals or 
organizations.

To "modify" a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the making of an exact copy. The 
resulting work is called a "modified version" of the earlier work or a work "based on" the earlier work.

A "covered work" means either the unmodified Program or a work based on the Program.

To "propagate" a work means to do anything with it that, without permission, would make you directly or secondarily liable for infringement under applicable copy-
right law, except executing it on a computer or modifying a private copy. Propagation includes copying, distribution (with or without modification), making available 
to the public, and in some countries other activities as well.

To "convey" a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with a user through a computer network, 
with no transfer of a copy, is not conveying.

An interactive user interface displays "Appropriate Legal Notices" to the extent that it includes a convenient and prominently visible feature that (1) displays an 
appropriate copyright notice, and (2) tells the user that there is no warranty for the work (except to the extent that warranties are provided), that licensees may convey 
the work under this License, and how to view a copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in 
the list meets this criterion.

1. Source Code.

The "source code" for a work means the preferred form of the work for making modifications to it. "Object code" means any non-source form of a work.

A "Standard Interface" means an interface that either is an official standard defined by a recognized standards body, or, in the case of interfaces specified for a partic-
ular programming language, one that is widely used among developers working in that language.

The "System Libraries" of an executable work include anything, other than the work as a whole, that (a) is included in the normal form of packaging a Major Compo-
nent, but which is not part of that Major Component, and (b) serves only to enable use of the work with that Major Component, or to implement a Standard Interface 
for which an implementation is available to the public in source code form. A "Major Component", in this context, means a major essential component (kernel, win-
dow system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an object code inter-
preter used to run it.

The "Corresponding Source" for a work in object code form means all the source code needed to generate, install, and (for an executable work) run the object code 
and to modify the work, including scripts to control those activities. However, it does not include the work's System Libraries, or general-purpose tools or generally 
available free programs which are used unmodified in performing those activities but which are not part of the work. For example, Corresponding Source includes 
interface definition files associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms that the work is spe-
cifically designed to require, such as by intimate data communication or control flow between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source.

The Corresponding Source for a work in source code form is that same work.

2. Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the stated conditions are met. This License 
explicitly affirms your unlimited permission to run the unmodified Program. The output from running a covered work is covered by this License only if the output, 
given its content, constitutes a covered work. This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You may convey 
covered works to others for the sole purpose of having them make modifications exclusively for you, or provide you with facilities for running those works, provided 
that you comply with the terms of this License in conveying all material for which you do not control copyright. Those thus making or running the covered works for 
you must do so exclusively on your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material out-
side their relationship with you.

Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; section 10 makes it unnecessary.

3. Protecting Users' Legal Rights From Anti-Circumvention Law.

No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under article 11 of the WIPO copyright 
treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such circumvention is effected by 
exercising rights under this License with respect to the covered work, and you disclaim any intention to limit operation or modification of the work as a means of 
enforcing, against the work's users, your or third parties' legal rights to forbid circumvention of technological measures.

4. Conveying Verbatim Copies.
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You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each 
copy an appropriate copyright notice; keep intact all notices stating that this License and any non-permissive terms added in accord with section 7 apply to the code; 
keep intact all notices of the absence of any warranty; and give all recipients a copy of this License along with the Program.

You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.

5. Conveying Modified Source Versions.

You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code under the terms of section 4, provided 
that you also meet all of these conditions:

a. The work must carry prominent notices stating that you modified it, and giving a relevant date.

b. The work must carry prominent notices stating that it is released under this License and any conditions added under section 7. This requirement modifies 
the requirement in section 4 to "keep intact all notices".

c. You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This License will therefore apply, along 
with any applicable section 7 additional terms, to the whole of the work, and all its parts, regardless of how they are packaged. This License gives no 
permission to license the work in any other way, but it does not invalidate such permission if you have separately received it.

d. If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has interactive interfaces that do not 
display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the covered work, and which are not com-
bined with it such as to form a larger program, in or on a volume of a storage or distribution medium, is called an "aggregate" if the compilation and its resulting 
copyright are not used to limit the access or legal rights of the compilation's users beyond what the individual works permit. Inclusion of a covered work in an aggre-
gate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the machine-readable Corresponding Source 
under the terms of this License, in one of these ways:

a. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source 
fixed on a durable physical medium customarily used for software interchange.

b. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by a written offer, valid for at 
least three years and valid for as long as you offer spare parts or customer support for that product model, to give anyone who possesses the object code 
either (1) a copy of the Corresponding Source for all the software in the product that is covered by this License, on a durable physical medium customarily 
used for software interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) access to copy the 
Corresponding Source from a network server at no charge.

c. c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This alternative is allowed only 
occasionally and noncommercially, and only if you received the object code with such an offer, in accord with subsection 6b.

d. d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access to the Corresponding Source in 
the same way through the same place at no further charge. You need not require recipients to copy the Corresponding Source along with the object code. 
If the place to copy the object code is a network server, the Corresponding Source may be on a different server (operated by you or a third party) that 
supports equivalent copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding Source. 
Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for as long as needed to satisfy these 
requirements.

e. e) Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and Corresponding Source of the work 
are being offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in conveying the 
object code work.

A "User Product" is either (1) a "consumer product", which means any tangible personal property which is normally used for personal, family, or household purposes, 
or (2) anything designed or sold for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases shall be resolved in favor 
of coverage. For a particular product received by a particular user, "normally used" refers to a typical or common use of that class of product, regardless of the status 
of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the product. A product is a consumer product regardless 
of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent the only significant mode of use of the product.

"Installation Information" for a User Product means any methods, procedures, authorization keys, or other information required to install and execute modified ver-
sions of a covered work in that User Product from a modified version of its Corresponding Source. The information must suffice to ensure that the continued func-
tioning of the modified object code is in no case prevented or interfered with solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying occurs as part of a transaction in which 
the right of possession and use of the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the transaction is characterized), 
the Corresponding Source conveyed under this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor 
any third party retains the ability to install modified object code on the User Product (for example, the work has been installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to provide support service, warranty, or updates for a work that has 
been modified or installed by the recipient, or for the User Product in which it has been modified or installed. Access to a network may be denied when the modifica-
tion itself materially and adversely affects the operation of the network or violates the rules and protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly documented (and with an 
implementation available to the public in source code form), and must require no special password or key for unpacking, reading or copying.

7. Additional Terms.

"Additional permissions" are terms that supplement the terms of this License by making exceptions from one or more of its conditions. Additional permissions that 
are applicable to the entire Program shall be treated as though they were included in this License, to the extent that they are valid under applicable law. If additional 
permissions apply only to part of the Program, that part may be used separately under those permissions, but the entire Program remains governed by this License 
without regard to the additional permissions.

When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from any part of it. (Additional permis-
sions may be written to require their own removal in certain cases when you modify the work.) You may place additional permissions on material, added by you to a 
covered work, for which you have or can give appropriate copyright permission.
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Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the copyright holders of that material) supple-
ment the terms of this License with terms:

a. Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or

b. Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate Legal Notices displayed by works 
containing it; or

c. Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in reasonable ways as different 
from the original version; or

d. Limiting the use for publicity purposes of names of licensors or authors of the material; or

e. Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or

f. Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions of it) with contractual 
assumptions of liability to the recipient, for any liability that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered "further restrictions" within the meaning of section 10. If the Program as you received it, or any part of it, 
contains a notice stating that it is governed by this License along with a term that is a further restriction, you may remove that term. If a license document contains a 
further restriction but permits relicensing or conveying under this License, you may add to a covered work material governed by the terms of that license document, 
provided that the further restriction does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the additional terms that apply to those files, 
or a notice indicating where to find the applicable terms.

Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions; the above requirements apply either 
way.

8. Termination.

You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to propagate or modify it is void, and will 
automatically terminate your rights under this License (including any patent licenses granted under the third paragraph of section 11).

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright 
holder explicitly and finally terminates your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior 
to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the violation by some reasonable means, 
this is the first time you have received notice of violation of this License (for any work) from that copyright holder, and you cure the violation prior to 30 days after 
your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you under this License. If your rights 
have been terminated and not permanently reinstated, you do not qualify to receive new licenses for the same material under section 10.

9. Acceptance Not Required for Having Copies.

You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered work occurring solely as a conse-
quence of using peer-to-peer transmission to receive a copy likewise does not require acceptance. However, nothing other than this License grants you permission to 
propagate or modify any covered work. These actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, 
you indicate your acceptance of this License to do so.

10. Automatic Licensing of Downstream Recipients.

Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and propagate that work, subject to 
this License. You are not responsible for enforcing compliance by third parties with this License.

An "entity transaction" is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an organization, or merging organiza-
tions. If propagation of a covered work results from an entity transaction, each party to that transaction who receives a copy of the work also receives whatever 
licenses to the work the party's predecessor in interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the 
work from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, you may not impose a license fee, roy-
alty, or other charge for exercise of rights granted under this License, and you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging 
that any patent claim is infringed by making, using, selling, offering for sale, or importing the Program or any portion of it.

11. Patents.

A "contributor" is a copyright holder who authorizes use under this License of the Program or a work on which the Program is based. The work thus licensed is called 
the contributor's "contributor version".

A contributor's "essential patent claims" are all patent claims owned or controlled by the contributor, whether already acquired or hereafter acquired, that would be 
infringed by some manner, permitted by this License, of making, using, or selling its contributor version, but do not include claims that would be infringed only as a 
consequence of further modification of the contributor version. For purposes of this definition, "control" includes the right to grant patent sublicenses in a manner 
consistent with the requirements of this License.

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor's essential patent claims, to make, use, sell, offer for sale, 
import and otherwise run, modify and propagate the contents of its contributor version.

In the following three paragraphs, a "patent license" is any express agreement or commitment, however denominated, not to enforce a patent (such as an express per-
mission to practice a patent or covenant not to sue for patent infringement). To "grant" such a patent license to a party means to make such an agreement or commit-
ment not to enforce a patent against the party.

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for anyone to copy, free of charge 
and under the terms of this License, through a publicly available network server or other readily accessible means, then you must either (1) cause the Corresponding 
Source to be so available, or (2) arrange to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the 
requirements of this License, to extend the patent license to downstream recipients. "Knowingly relying" means you have actual knowledge that, but for the patent 
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license, your conveying the covered work in a country, or your recipient's use of the covered work in a country, would infringe one or more identifiable patents in that 
country that you have reason to believe are valid.

If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a covered work, and grant a patent 
license to some of the parties receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work, then the patent 
license you grant is automatically extended to all recipients of the covered work and works based on it.

A patent license is "discriminatory" if it does not include within the scope of its coverage, prohibits the exercise of, or is conditioned on the non-exercise of one or 
more of the rights that are specifically granted under this License. You may not convey a covered work if you are a party to an arrangement with a third party that is 
in the business of distributing software, under which you make payment to the third party based on the extent of your activity of conveying the work, and under which 
the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with copies of the covered 
work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with specific products or compilations that contain the covered 
work, unless you entered into that arrangement, or that patent license was granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may otherwise be available to you under 
applicable patent law.

12. No Surrender of Others' Freedom.

If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the con-
ditions of this License. If you cannot convey a covered work so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, 
then as a consequence you may not convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to whom 
you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the Program.

13. Use with the GNU Affero General Public License.

Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work licensed under version 3 of the GNU 
Affero General Public License into a single combined work, and to convey the resulting work. The terms of this License will continue to apply to the part which is the 
covered work, but the special requirements of the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combi-
nation as such.

14. Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. Such new versions will be similar in 
spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU General Public License "or any later ver-
sion" applies to it, you have the option of following the terms and conditions either of that numbered version or of any later version published by the Free Software 
Foundation. If the Program does not specify a version number of the GNU General Public License, you may choose any version ever published by the Free Software 
Foundation.

If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that proxy's public statement of acceptance of 
a version permanently authorizes you to choose that version for the Program.

Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any author or copyright holder as a result 
of your choosing to follow a later version.

15. Disclaimer of Warranty.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN 
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PAR-
TICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM 
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY 
WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT 
NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE 
OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE POS-
SIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, reviewing courts shall apply local 
law that most closely approximates an absolute waiver of all civil liability in connection with the Program, unless a warranty or assumption of liability accompanies 
a copy of the Program in return for a fee.
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LGPL
GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the 
additional permissions listed below.

0. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the "GNU GPL" refers to version 3 of the GNU General Public 
License.

"The Library" refers to a covered work governed by this License, other than an Application or a Combined Work as defined below.

An "Application" is any work that makes use of an interface provided by the Library, but which is not otherwise based on the Library. Defining a subclass of a class 
defined by the Library is deemed a mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the Library. The particular version of the Library with which the Combined

Work was made is also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for portions of the

Combined Work that, considered in isolation, are based on the Application, and not on the Linked Version.

The "Corresponding Application Code" for a Combined Work means the object code and/or source code for the Application, including any data and utility programs 
needed for reproducing the Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by an Application that uses the facility (other than 
as an argument passed when the facility is invoked), then you may convey a copy of the modified version:

a. under this License, provided that you make a good faith effort to ensure that, in the event an Application does not supply the function or data, the facility 
still operates, and performs whatever part of its purpose remains meaningful, or

b. under the GNU GPL, with none of the additional permissions of this License applicable to that copy.

3. Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that is part of the Library. You may convey such object code under terms of your 
choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts and accessors, or small macros, inline functions and 
templates (ten or fewer lines in length), you do both of the following:

a. Give prominent notice with each copy of the object code that the Library is used in it and that the Library and its use are covered by this License.

b. Accompany the object code with a copy of the GNU GPL and this license document.

4. Combined Works.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in 
the Combined Work and reverse engineering for debugging such modifications, if you also do each of the following:

a. Give prominent notice with each copy of the Combined Work that the Library is used in it and that the Library and its use are covered by this License.

b. Accompany the Combined Work with a copy of the GNU GPL and this license document.

c. For a Combined Work that displays copyright notices during execution, include the copyright notice for the Library among these notices, as well as a 
reference directing the user to the copies of the GNU GPL and this license document.

d. Do one of the following:

1) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding Application Code in a form suitable for, and under 
terms that permit, the user to recombine or relink the Application with a modified version of the Linked Version to produce a modified Combined Work, 
in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

2) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (a) uses at run time a copy of the Library 
already present on the user's computer system, and (b) will operate properly with a modified version of the Library that is interface-compatible with the 
Linked Version.

e. Provide Installation Information, but only if you would otherwise be required to provide such information under section 6 of the GNU GPL, and only to 
the extent that such information is necessary to install and execute a modified version of the Combined Work produced by recombining or relinking the 
Application with a modified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany the Minimal 
Corresponding Source and Corresponding Application Code. If you use option 4d1, you must provide the Installation Information in the manner specified 
by section 6 of the GNU GPL for conveying Corresponding Source.)

5. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a single library together with other library facilities that are not Applications and 
are not covered by this License, and convey such a combined library under terms of your choice, if you do both of the following:
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a. Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities, conveyed under the 
terms of this License.

b. Give prominent notice with the combined library that part of it is a work based on the Library, and explaining where to find the accompanying 
uncombined form of the same work.

6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License from time to time. Such new versions will be sim-
ilar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a certain numbered version of the GNU Lesser General Public 
License "or any later version" applies to it, you have the option of following the terms and conditions either of that published version or of any later version published 
by the Free Software Foundation. If the Library as you received it does not specify a version number of the GNU Lesser General Public License, you may choose any 
version of the GNU Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General Public License shall apply, that proxy's public 
statement of acceptance of any version is permanent authorization for you to choose that version for the Library.

MIT

Copyright 1987, 1988 by MIT Student Information Processing Board.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose is hereby granted, provided that the names of M.I.T. and the 
M.I.T. S.I.P.B. not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. M.I.T. and the M.I.T. 
S.I.P.B. make no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty. 

zlib

Copyright (C) 1995-1998 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this soft-
ware.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the follow-
ing restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, 
an acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.Jean-loup Gailly Mark Adler jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for Comments) 1950 to 1952 in the files ftp://ds.internic.net/rfc/rfc1950.txt (zlib format), 
rfc1951.txt (deflate format) and rfc1952.txt (gzip format).
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Glossary
The following terms are used throughout this guide:

Active image — the portion of the video picture area (production aperture) that is being utilized for output content. 
Active image excludes letterbox bars and pillarbox bars.

Auto Select Key — a key in which two video signals are required to insert the key. The Key Alpha is used to cut 
the hole in the video, and the Key Video is used to fill that hole.

Card — openGear terminal devices within openGear frames, including all components and switches.

DashBoard — the DashBoard Control System.

DTVCC captions — CEA-708 captions.

Frame — the openGear frame that houses the GATOR-KEY unless otherwise noted. 

HTTP — Direct Hypertext Transfer Protocol.

LTC — Linear Timecode.

MIB — management information base.

Network Controller Card — the MFC-OG3-N and any available options unless otherwise noted.

NTSC captions — the CEA-608-D: Line 21 Data Services captions.

openGear Frame — refers to the OG3-FR series and OGX-FR series frames unless otherwise noted. 

PAL — PAL-B and PAL-G unless otherwise noted.

Production aperture — the image lattice that represents the maximum possible image extent in a given standard 
(e.g. the full size of all active pixels and active lines). For example, the 1080i production aperture would be 
1920x1080.

Self Key — a key in which the luminance, or brightness, values of the key source is used as the alpha for hte key.

System— the mix of interconnected production and terminal equipment in your environment.

TCP — Transmission Control Protocol.

TTL — Time To Live.

UDP — User Datagram Protocol.

User — the person who uses the GATOR-KEY.

VGPI — Virtual GPI feature of the Miranda™ Presmaster Automation protocol.
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